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KATA PENGANTAR  

 

Alhamdulillaahirobbil’alamin. Sesungguhnya pujian hanyalah untuk Allah, 

Sujud dan syukur kepada Allah SWT atas segala rahmat dan karunia-Nya sehingga 

diberikan kemudahan serta kelancaran dalam menyelesaikan penyusunan Modul Praktikum 

Statistika Industri untuk Mahasiswa/i pada Program Studi Teknik Industri ini. Dengan 

Modul Praktikum ini, diharapkan dapat memberikan masukan dan bermanfaat dalam 

memperdalam aplikasi dari penguasaan teori Statistika Industri. Dalam praktikum ini 

software yang digunakan adalah software SPSS. Praktikum Statistika ini mempelajari 

tentang teknik pengolahan data menggunakan metode-metode statistika. Akhirnya, Penulis 

menyadari bahwa dalam penyusunan modul ini masih jauh dari kesempurnaan. Oleh karena 

itu segala kritik, masukan dan saran demi kesempurnaan modul praktikum ini sangat 

diharapkan. Semoga modul praktikum Statistika Industri ini akan memberikan manfaat yang 

berguna, khususnya bagi para peserta praktikum.  
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BAB I PENGENALAN PRAKTIKUM STATISTIK  

 

1.1 Deskripsi Materi  

Materi praktikum statistik industri terdiri dari analisis statistik deskriptif, 

statistikparametrik dan statistik non parametrik. Praktikum statistik diharapkan 

dapat membantumahasiswa dalam mengolah dan menganalisis data dengan 

metode statistik. Materi-materipada Praktikum Statistik industri antara lain 

Statistik Deskriptif, membuatberbagai grafik dan diagram, Uji Keseragaman 

Data, Uji Hipotesis, Uji Distribusi (UjiChi Square dan Kolmogorov Smirnov), 

Anova (satu faktor dan dua faktor), Korelasi, dan Regresi, Statistik 

Multivariate. Dalam modul ini terdapat contoh-contoh yang dapat membantu 

mahasiswa dalam memahami materi yang telah disampaikan. Dari hasil 

praktikum ini diharapkan dapat membantu mahasiswa dalam mempelajari 

berbagai aplikasi statistik pada khususnya dalam dunia industri dan pada 

umumnya di masyarakat yang semakin berkembang. Setelah mempelajari 

modul ini, mahasiswa diharapkan mampu melakukan pengolahan data yang 

bersifatk statistikal dan menganalisis hasil data menggunakan software statistik 

yaitu SPSS (Statistical Program for Social Science).  

  

1.2 Prasyarat Praktikum  

Syarat yang harus dipenuhi oleh mahasiswa sebelum melakukan praktikum 

statistik industri adalah sebagai berikut:  

1. Mahasiswa mampu mengoperasikan komputer.  

2. Mahasiswa tidak asing dengan istilah-istilah komputer seperti mouse, klik 

ganda, klik kanan, enter dan sebagainya.  

3. Mahasiswa disarankan telah mengambil mata kuliah APTI I untuk 

membuka wacana pengetahuan teknologi dasar.  

4. Mahasiswa diwajibkan telah lulus dari mata kuliah Statistik Industri I.  

  

1.3 Petunjuk Pemakaian Modul  

Modul ini dapat digunakan mahasiswa dengan pertimbangan sebagai berikut:  

1. Mahasiswa telah memiliki modul dan telah membaca modul sebelum mata 

kuliah dimulai.  

2. Mahasiswa mempelajari serta mengidentifikasi isi modul yang diuraikan 

lebihrinci oleh dosen pengampu.  

3. Mahasiswa dan dosen mendiskusikan materi untuk mencari 

penyelesaianterhadap kasus tertentu.  

4. Mahasiswa menyimpulkan isi materi yang didiskusikan  

5. Mahasiswa menjawab soal latihan yang diberikan  

6. Pemberian pengayaan materi bagi mahasiswa yang telah memahami 

danmenyelesaikan soal latihan.  

7. Memberikan tinjauan ulang terhadap materi sekaligus mengidentifikasi 

kesulitan-kesulitan mahasiswa dalam memahami materi.  
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1.4 Standar Kompetensi  

Standar kompetensi yang harus dimiliki oleh mahasiswa (praktikan) dari 

praktikum statistik industri ini adalah sebagai berikut:  

1. Mahasiswa mampu melakukan pengolahan data dengan software SPSS  

2. Mampu melakukan analisis statistik deskriptif maupun inferensial dari data 

statistik yang didapatkan.  

3. Mampu menarik kesimpulan, berdasarkan data statistik yang dibuat.  
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BAB II  

PENGENALAN SOFTWARE SPSS (Statistical Program for Social Science)  

  

2.1 Kompetensi Dasar  

Setelah mempelajari bab ini, diharapkan mahasiswa dapat:  

1. Mengetahui dan memahami proses penggunaan software SPSS  

2. Dapat memahami beragam menu dan fungsi dari software SPSS  

3. Mampu memahami pengaturan Variabel View  

4. Mampu menginputkan data statistik pada Data View. 

  

2.2 Indikator  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheetsoftware SPSS  

4. Input data pada software SPSS . 

  

2.3 Landasan Teori  

SPSS (Statistical Program for Social Science) adalah program aplikasi 

komputeruntuk menganalisis data statistik. Program ini hampir banyak 

digunakan untukmenganalisis data-data dari berbagai berbagai bidang bisnis 

dan background keilmuan.Software ini telah dikembangkan sejak sekitar tahun 

1960 sebagai sistem statistik padakomputer mainframe oleh Norman H. Nie dan 

Dale Bent dari Standford University. Seiring dengan perkembangan teknologi 

software ini telah mengalami perubahan dan penyesuaian, baik dari segi utilitas, 

tampilan dan juga sistem operasi.SPSS merupakan salah satu sekian banyak 

software statistika yang telah dikenal luas dikalangan penggunaannya. 

Disamping masih banyak lagi software statistika lainnyaseperti Minitab, 

Syastas, Microstat dan masih banyak lagi. SPSS sebagai sebuah 

softwarestatistika yang banyak digunakan karena mempunyai banyak 

kelebihan, salah satukelebihannya adalah mudah dalam pengoperasiannya. 

Tampilan utama worksheet SPSS dibawah ini.  
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Keterangan :  

1. Menu bar adalah Kumpulan perintah – perintah dasar untuk mengoperasikan 

SPSS. Perintah – perintah yang terdapat pada menu bar adalah File, Edit, View, 

Data,Transform, Analyze, Graphs, Utilities, Windows, dan Help. Menu yang 

terdapat pada SPSS adalah:  

a. File  

Isi dari perintah – perintah yang ada pada menu bar File disajikan dalam 

gambar dibawah ini.  

 
  

Gambar 2.2 Tampilan Menu File  

  

b. Edit  

Untuk melakukan pengeditan pada operasi SPSS baik data, serta pengaturan 

atau option untuk konfigurasi SPSS secara keseluruhan. Tampilan dari 

perintah menubar Edit disajikan dalam gambar di bawah ini.  

 

Gambar 2.3 Tampilan Menu Edit  

  

  

  



5  

  

c. View  

Untuk pengaturan tambilan di layar kerja SPSS, serta mengetahui proses 

proses yang sedang terjadi pada operasi SPSS. Tampilan perintah menu bar 

View disajikan dalam gambar di bawah ini.  

 
Gambar 2.4 Tampilan Menu View  

  

d. Data  

Menu data digunakan untuk melakukan pemrosesan data. Tampilan menu bar 

data disajikan pada gambar di bawah ini.  

 

Gambar 2.5 Tampilan Menu Data  

  

e. Transform  

Menu transform dipergunakan untuk melakukan perubahan-perubahan atau 

penambahan data. Tampilan perintah dari menu bar Transform.  
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Gambar 2.6 Tampilan Menu Transform  

  

f. Analyze  

Menu analyze digunakan untuk melakukan analisis data yang telah kita 

masukkan ke dalam komputer. Menu ini merupakan menu yang terpenting 

karena semuapemrosesan dan analisis data dilakukan dengan menggunakan 

menu ini. Tampilan perintah-perintah analyze pada menu Bar.  

 

  

Gambar 2.7 Tampilan Menu Analyze  
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g. Graph  

Menu graph digunakan untuk membuat grafik, diantaranya ialah bar, line, 

pie, dll.  

  

h. UTILITIES  

Menu utilities dipergunakan untuk mengetahui informasi variabel, informasi 

file,dll.  

  

i. ADD – ONS  

Menu ad-ons digunakan untuk memberikan perintah kepada SPSS jika ingin 

menggunakan aplikasi tambahan, misalnya menggunakan aplikasi Amos, 

SPSS dataentry, text analysis, dsb.  

  

j. WINDOWS  

Menu windows digunakan untuk melakukan perpindahan (switch) dari satu 

file kefile lainnya.  

  

k. HELP  

Menu help digunakan untuk membantu pengguna dalam memahami 

perintah-perintah SPSS jika menemui kesulitan  

  

2. Tools Bar  

Tools bar merupakan Kumpulan perintah–perintah yang sering digunakan 

dalam bentuk gambar. Contoh tampilan tool bar, pada gambar di bawah ini.  

  

 

Gambar 2.8 Tampilan Tools Bar  
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BAB III INPUT DATA  

  

Worksheet software SPPS ada dua bagian yaitu bagian pertama adalah 

Variabel View yang berisi pengaturan input nama variabel–variabel dan bagian 

kedua disebutdengan Data View yang mana digunakan untuk tempat entry data. 

Pada data view, nama variabel akan berubah menyesuaikan pengaturan pada 

Variabel View. Tampilan worksheet variabel view di bawah ini.  

 

Gambar 3.1 Tampilan Worksheet Variabel View  

  

Pada gambar 3.1 di atas, terdapat sepuluh atribut variable yang perlu didefinisikan, 

yaitu:  

1. Name, merupakan nama variabel yang akan ditampilkan di baris teratas pada 

tampilan data  view, seperti nama, pendidikan, umur, jumlah penjualan, dsb.  

2. Type, merupakan tipe variabel yang di pakai. Ada delapan tipe variabel dalam 

SPSS.Akan tetapi secara umum dapat digolongkan menjadi dua, yaitu variabel 

angka(numeric, comma, dot, scientific, notation, date, dollar, dan custom 

currency) danvariabel non angka (string).  

    

Gambar 3.2 Tampilan Kotak Dialog Type  

    

3. Width, merupakan lebar kolom yang nilai defaultnya 8  

4. Decimals, merupakan jumlah digit setelah koma  

5. Label, merupakan penjelasan atribut variabel name yang muncul di dalam kotak 

dialog apabila anda melakukan analisis lebih lanjut.  
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6. Value, merupakan pengkodean di variabel. Contoh, program studi diberi kode 1 

untuk Teknik Industri, kode 2 untuk Teknik Sipil, kode 3 untuk Teknik Elektro, 

dan kode 4 untuk Arsitektur. Langkah pengkodean di SPSS adalah klik sel di 

kolom value yang akan diberi pengkodean, maka akan muncul kotak dialog 

value labels.  

 

Gambar 3.3 Kotak Dialog Value Lables  

  

Tulis angka 1 di dalam value dan tulis Teknik Industri di dalam label kemudian 

klik Add maka akan muncul dalam kotak 1.00 = “Teknik Industri”. Lakukan 

langkah yang sama untuk kode 2, 3, dan 4. Jika sudah selesai melakukan input 

kode di seluruh value, klik OK.  

7. Missing, menetapkan nilai khusus data sebagai user missing.  

8. Columns, mempunyai fungsi seperti width  

9. Align, merupakan posisi data dalam cell  

10. Measure, merupakan tipe data yang digunakan. Secara otomatis SPSS akan 

memilih SCALE untuk tipe numeric, sedangkan untuk tipe string terdapat dua 

pilihan, yaituORDINAL atau NOMINAL.Worksheet untuk data view 

digunakan sebagai data editor untuk memulai inputdata. Tampilan worksheet 

data view di bawah ini.  

 
Gambar 3.4 Tampilan Worksheet Data View  
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BAB IV STATISTIK DESKRIPTIF  

  

4.1 Komptensi Dasar  

Kompetensi dasar yang harus dimiliki oleh mahasiswa setelah mempelajari 

statistik desktiptif adalah sebagai berikut:  

1. Mengetahui dan memahami jenis analisis statistik.  

2. Dapat memahami pengolahan data dengan analisis statistik deskriptif.  

3. Mampu memahami dan mengambil kesimpulan dari hasil pengolahan 

dengan analisis statistik deskriptif.  

  

4.2 Indikator  

Indikasi dari materi statistik deskriptif ini untuk mahasiswa adalah sebagai 

berikut:  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheet software SPSS  

4. Input data pada software SPSS  

5. Mempelajari penggunaan aplikasi analisis statistik deskriptif  

  

4.3 Landasan Teori  

Statistika dibedakan menjadi dua bagian, yaitu :  

1. Statistika deskriptif, yaitu statistika yang berusaha untuk menjelaskan 

danmenggambarkan karakteristik data, seperti mencari rata-rata, standar 

deviasi, median, dan lain-lain.  

2. Statistika inferensia, yaitu statistik yang berusaha untuk memperlihatkan, 

meramalkan karakteristik data dari data yang tersedia.Pengukuran deskriptif 

pada dasarnya adalah memaparkan secara numerik dua hal pokok 

pengukuran data, yaitu (1) tendensi sentral dan (2) disperse. SPSS 

mengkategorikan analisis statistik deskriptif di dalam 5 kategori yang 

terdapat pada menu utama analyze, pada menu tersebut memiliki beberapa 

sub menu yaitu :  

a.   Frequencies  

Frequencies membahas mengenai penjabaran ukuran statistika 

deskriptif seperti mean, median, ragam, kuartil, persentil, dan lain-lain.  

b. Descriptives  

Descriptive antara lain berfungsi untuk mengetahui skor Z dari suatu 

distribusi data dan untuk menguji apakah suatu data menyebar normal 

atau tidak.  

c. Explore  

Explore berfungsi untuk memeriksa lebih teliti suatu data. Selain dari 

alat untuk menguji apakah suatu data menyebar normal atau tidak, sub 

menu ini juga terdapat fasilitas untuk membuat diagram box – plot dan 

diagram batang daun (steam and leaf plot).  
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d. Crosstabs  

Crosstabs digunakan untuk menyajikan deskriptif data dalam bentuk 

tabel silang yang terdiri atas baris dan kolom, selain itu juga berisi untuk 

menguji hubungan antara baris dan kolom.  

e. Ratio  

Ratio menggambarkan rasio antara dua variabel skala.  

  

4.4.Studi Kasus 1. Entry Data  

Data masukan dalam pengolahan statistik deskriptif ini adalah data yang 

memiliki beberapa variabel untuk diketahui karakteristik dari masing-masing 

variabel tersebut berdasarkan jumlah yang ada, seperti rata-rata, standar deviasi, 

media, modus dan lain-lain. Berikut merupakan contoh data yang dapat digunakan 

dalam pengolahan statistik deskriptif.  

  

 

Tabel 4.1 Data uji statistika deskriptive  

Hari 

Kerja  

Bahan 

Baku  

Hasil 

Produksi  

Pemakaian 

Batu Bara  

Limbah  

Onggok  

Limbah  

Kulit  

Tanah  

1  2245  270  47  431  95  

2  2090  257  47  405  89  

3  1745  171  45  365  80  

4  1594  272  30  244  54  

5  1820  250  47  406  89  

6  1424  262  43  357  79  

7  1612  262  45  392  86  

8  1584  251  45  374  82  

9  1713  206  43  377  83  

10  1723  265  36  294  65  

11  1847  260  46  378  83  

12  1759  237  45  335  86  

13  1742  241  41  341  74  

14  1882  255  42  360  75  

15  1621  252  44  316  79  

16  1850  257  44  351  70  

17  1983  280  45  401  77  

18  1250  244  49  348  86  

19  2111  233  42  332  77  
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Hari 

Kerja  

Bahan 

Baku  

Hasil 

Produksi  

Pemakaian 

Batu Bara  

Limbah  

Onggok  

Limbah  

Kulit  

Tanah  

20  2071  218  40  340  73  

21  3004  277  38  395  75  

22  2921  290  48  434  87  

23  2944  307  50  416  95  

24  2544  298  53  406  92  

25  2387  295  52  462  90  

26  2264  271  51  421  102  

27  2733  290  47  432  93  

28 2289 286 51 211 94 

29 2789 259 42 231 90 

30 3456 321 41 356 91 

31 2134 267 43 235 92 

32 2400 245 45 234 78 

33 2387 214 51 209 77 

34 3578 378 54 359 65 

35 3451 342 52 347 74 

36 3267 326 41 376 68 

37 3470 358 45 358 95 

38 3569 390 42 373 79 

39 3267 341 44 357 87 

40 3890 368 43 385 86 

 

Data di atas adadalah data produksi tepung tapioka yang menghasilkan 

limbah onggok dan limbah kulit tanah.  

  

2. Analisis Data  

Langkah-langkah yang dilakukan untuk melakukan analisis statistik deskriptif 

adalah sebagai berikut:  

Input data tabel di atas kedalam software SPSS  

a. Klik Analyze pilih Descriptive Statistics selanjutnya pilih Frequencies, 

kemudain akan muncul kotak dialog Frequencies  

  



13  

  

 

Gambar 4.1 Kotak Dialog Analyze  

  

b. Masukan variabel Hari kerja, bahan baku, hasil produksi, pemakaiana batu 

bara,limbah onggok dan limbah kulit kayu kedalam kotak variabel  

  

  

Gambar 4.2 Kotak Dialog Frequencies  

  

c. Pilih Statistic, maka kotak dialog Frequencies Statistics muncul.  

Tetapkan parameter pengukuran dan klik Continue  
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\  

  

  

  

  

  

  

  

  

  

  

  

Gambar 4.3 Kotak Dialog Frequencies Statstic  

  

d. Pilih Chart apabila anda akan melakukan analisis secara grafis dan pilih 

tipe grafis yang dikehendaki lalu klik Continue  

 

Gambar 4.4 Kotak Dialog Frequencies Chart  

  

e. Klik Format untuk menentukan susuna format data. Secara default pilih  

Ascending Value (diurutkan dari kecil ke besar), lalu klik Continue dan  

OK  

  

Gambar 4.5 Kotak Dialog Frequencies Format  
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f. Hasil pengolahan data di atas adalah sebagai berikut:  

  

Tabel 4.3 Tabel Hasil Pengolahan  

 

Statistics 

 
Hari_Kerj

a 

Bahan_Bak

u 

Hasil_Produ

ksi 

Pemakaian_

Batu_Bara 

Limbah_Ong

gok 

Limbah_Kulit

_Tanah 

N Valid 40 40 40 40 40 40 

Missing 0 0 0 0 0 0 

Mean 20.50 2360.25 276.65 44.98 353.60 82.30 

Median 20.50 2189.50 266.00 45.00 359.50 83.00 

Mode 1a 2387a 257a 45 357a 86 

Percentile

s 

25 10.25 1748.50 250.25 42.00 336.25 75.50 

50 20.50 2189.50 266.00 45.00 359.50 83.00 

75 30.75 2938.25 297.25 47.75 399.50 90.00 

a. Multiple modes exist. The smallest value is shown 

Dapat diketahui bahwa data yang digunakan sebanyak 40 data dengan nilai 

rata-rata untuk variabel bahan baku 2360,25, hasil produksi 276,65, 

pemakaian batu bara 44,98, limbah onggok 353,60, dan limbah kulit tanah 

82,30 Begitu seterusnya sampai hasil persentil yang dihasilkan dari 

pengolahan 40 data tersebut.  

 

3.   Tugas Kelas 

Lakukan pengujian ulang untuk mengetahui hasil rata-rata variable 50 data 

dibawah ini!  

Tabel 4.4 Kegiatan Produksi  

Hari 

Kerja 

Komoditas 

(Unit) 

Hasil 

Pengolahan 

(Kg) 

Pemakaian 

Bahan Baku 

(Kg) 

Limbah 

Diolah 

Kembali 

(Kg) 

Limbah 

Akhir 

(Kg) 

1 10 91 34 12 6 

2 22 95 41 14 6 

3 24 82 32 14 5 

4 17 97 44 13 8 

5 27 67 30 20 9 

6 22 83 48 13 5 

7 21 61 34 10 5 

8 27 75 33 14 8 

9 22 65 41 17 8 

10 25 92 36 18 6 

11 14 67 49 10 8 

12 20 86 40 15 5 
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Hari 

Kerja 

Komoditas 

(Unit) 

Hasil 

Pengolahan 

(Kg) 

Pemakaian 

Bahan Baku 

(Kg) 

Limbah 

Diolah 

Kembali 

(Kg) 

Limbah 

Akhir 

(Kg) 

13 25 60 45 14 10 

14 14 88 31 11 9 

15 19 77 41 13 6 

16 15 61 44 19 5 

17 10 96 32 11 5 

18 12 65 50 11 6 

19 17 68 44 20 9 

20 20 95 50 17 10 

21 24 91 33 14 7 

22 19 92 42 14 6 

23 16 67 32 14 7 

24 29 95 35 17 8 

25 23 76 39 20 5 

26 23 89 34 10 8 

27 13 98 38 13 10 

28 19 73 40 15 9 

29 20 66 50 13 7 

30 17 60 48 16 6 

31 12 60 39 19 5 

32 25 68 40 14 9 

33 14 99 39 10 7 

34 26 81 39 14 9 

35 27 96 37 20 8 

36 22 79 50 10 8 

37 11 76 41 15 6 

38 22 87 50 13 8 

39 27 76 49 16 7 

40 27 67 43 17 10 

41 16 62 47 18 5 

42 24 98 33 11 9 

43 14 62 42 17 7 

44 10 96 30 15 8 

45 16 96 48 19 8 

46 19 75 30 16 7 

47 16 69 37 11 10 

48 12 75 34 10 7 

49 13 70 40 20 8 

50 24 80 33 18 6 
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Analisis Deskriptif  

1. Data Entry  

Data yang digunakan dalam analisis deskriptif ini sama dengan data pada 

analisis frekuensi yang sebelumnya telah dibahas, hanya saja langkahlangkah 

yang dilakukan berbeda dan dengan hasil yang berbeda pula. Berikut adalah 

langkah-langkah yang dilakukan dalam analisis deskriptitf:  

a. Pilih menu Analyze lalu pilih Statistic Descriptive dan pilih 

Descriptive, maka akan muncul kotak dialog descriptive.  

  

 

Gambar 4.6 Kotak Dialog Analize  

  

b. Masukan variabel Before_Exp dan After_Exp kedalam kotak variabel  

(s)  

 
Gambar 4.7 Kotak Dialog Descriptive  

c. Beri tanda centang pada Save Standarized Value as Variables  dipojok 

kiri bawah kotak dialog kemudian klik OK  

  

Gambar 4.9 Kotak Dialog  Descriptives   
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Gambar 4.8 Kotak Dialog Descrptive  

  

d. Hasil pengolahan data sebagai berikut  

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Limbah_Onggok 40 209 462 353.60 63.829 

Limbah_Kulit_Tanah 40 54 102 82.30 10.029 

Valid N (listwise) 40     

Gambar 4.9Hasil Pengolahan Descriptives Statistics   

 

2. Analisis Hasil  

Dari hasil pengolahan di atas menunjukan bahwa nilai minimum dari variabel 

limbah onggok adalah 209, nilai maximum adalah 462, dengan nilai rata-rata 

353,60 dan standar devisai 63,829. Sedangkan untuk nilai minimum variabel 

limbah kulit tanah adalah 54, nilai maximum adalah 102, dengan nilai rata-rata 

82,30 dan standar deviasi 10,029.  

  

4.5 Analisis Explore  

1. Data Entry  

Data yang digunakan dalam analisis deskriptif ini sama dengan data pada 

analisis frekuensi dan analisis deskriptif yang sebelumnya telah dibahas, 

hanya saja langkah-langkah yang dilkaukan berbeda dan dengan hasil yang 

berbeda pula. Berikut adalah langkah-langkah yang dilakukan dalam analisis 

explore:  

a. Pilih menu Analyze lalu pilih Statistic Descriptive kemudian pilih  

Explore  

  

  

  

Gambar 4.10   Kotak Dialog  Descriptives   
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Gambar 4.10 Kotak Dialog Analyze  

  

b. Masukan variabel Limbah_Onggok ke dalam kotak Dependent List  

dan pindahkan variabel Bahan_Baku ke dalam kotak Factor List  

 

Gambar 4.11 Kotak Dialog Explore  

c. Pilih Statistics, maka akan muncul kotak dialog Exlore Statistics. 

Tetapkan parameter uji secara default, Descriptive Convidence  

Interval for Mean 95% dipilih, lalu klik Continue  

 
Gambar 4.12 Kotak Dialog Explore Statistics  

d. Pilih Plot, kemudain akan muncul kotak dialog Explore Plot. Secara 

default pilih  box plot factor level together and steam and leaf lalu 

klik Continue dan OK  
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Gambar 4.13 Kotak Dialog Explore Plots  

  

 1.   Tugas Kelas 

Lakukan pengujian ulang dan analisis untuk mengetahui hasil analisis frekuensi 

variabel 50 data dibawah ini! 

 

Tabel 4.5 Kegiatan Produksi  

Hari 

Kerja 

Komoditas 

(Unit) 

Hasil 

Pengolahan 

(Kg) 

Pemakaian 

Bahan Baku 

(Kg) 

Limbah 

Diolah 

Kembali 

(Kg) 

Limbah 

Akhir 

(Kg) 

1 10 91 34 12 6 

2 22 95 41 14 6 

3 24 82 32 14 5 

4 17 97 44 13 8 

5 27 67 30 20 9 

6 22 83 48 13 5 

7 21 61 34 10 5 

8 27 75 33 14 8 

9 22 65 41 17 8 

10 25 92 36 18 6 

11 14 67 49 10 8 

12 20 86 40 15 5 

13 25 60 45 14 10 

14 14 88 31 11 9 

15 19 77 41 13 6 

16 15 61 44 19 5 

17 10 96 32 11 5 

18 12 65 50 11 6 

19 17 68 44 20 9 

20 20 95 50 17 10 

21 24 91 33 14 7 
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Hari 

Kerja 

Komoditas 

(Unit) 

Hasil 

Pengolahan 

(Kg) 

Pemakaian 

Bahan Baku 

(Kg) 

Limbah 

Diolah 

Kembali 

(Kg) 

Limbah 

Akhir 

(Kg) 

22 19 92 42 14 6 

23 16 67 32 14 7 

24 29 95 35 17 8 

25 23 76 39 20 5 

26 23 89 34 10 8 

27 13 98 38 13 10 

28 19 73 40 15 9 

29 20 66 50 13 7 

30 17 60 48 16 6 

31 12 60 39 19 5 

32 25 68 40 14 9 

33 14 99 39 10 7 

34 26 81 39 14 9 

35 27 96 37 20 8 

36 22 79 50 10 8 

37 11 76 41 15 6 

38 22 87 50 13 8 

39 27 76 49 16 7 

40 27 67 43 17 10 

41 16 62 47 18 5 

42 24 98 33 11 9 

43 14 62 42 17 7 

44 10 96 30 15 8 

45 16 96 48 19 8 

46 19 75 30 16 7 

47 16 69 37 11 10 

48 12 75 34 10 7 

49 13 70 40 20 8 

50 24 80 33 18 6 
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4.6 Analisis Crosstabs  

1. Data Entry  

Data yang digunakan dalam melakukan pengolahan pada analisis crosstabs 

adalah hasil survey terhadap konsumen terhadap kualitas layanan, harga, 

lokasi dan fasilitas di Indomaret, Alfamart, dan DeaMart. 

(1) Indomaret, (2) Alfamart, dan (3) DeaMart. Masing-masing variabel 

memiliki value, yaitu:  

1 = Puas  

2 = Tidak Puas  

Dari data tersebut kemudian dilakukan pengolahan dengan langkah-langkah 

sebagai berikut: 

a. Input data pada SPSS sebagai berikut  

Tabel 4.6 Hasil Pengumpulan Data 

Market Pelayanan Harga Lokasi Fasilitas 

2 1 2 2 1 

1 1 2 2 1 

3 1 1 2 1 

2 1 1 1 2 

1 2 1 2 1 

3 1 1 1 1 

2 1 1 2 1 

1 1 1 1 1 

2 1 1 1 2 

1 2 1 1 1 

2 2 2 1 1 

2 1 2 2 1 

2 1 1 2 2 

1 1 1 1 2 

1 1 1 1 2 

2 1 2 1 1 

3 1 1 2 1 

3 1 1 1 1 

3 1 1 1 1 

1 2 1 2 1 

3 1 2 1 2 

3 2 1 1 1 

2 1 2 1 1 

3 2 2 2 2 

3 1 1 1 2 

3 1 2 1 1 

2 2 1 1 1 

1 1 2 1 1 
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Market Pelayanan Harga Lokasi Fasilitas 

3 2 2 1 2 

3 2 1 2 1 

 

b. Ubah data pada kolom Value yang ada di Variable View sesuai dengan 

nilai dari variabel yang telah ditentukan  

 

Gambar 4.15 Kotak Dialog Value  

  

c. Pilih menu Analyze lalu pilih Statistic Descriptive dan pilih  

Crosstabs  

 

Gambar 4.16 Kotak Dialog Analyze  

  

d. Inputkan variabel Mini_Market kedalam kotak Row (s) dan inputkan 

variabel Pelayanan, Harga, Lokasi dan Fasilitas ke kotak Column (s).  
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Gambar 4.17 Kotak Dialog Crosstabs  

  

e. Kemudian pilih Statistic, maka akan muncul kotak dialog Crosstabs 

Statistic, beri tanda centang pada Chi-square, pilih Continue dan klik  

OK  

 

Gambar 4.18 Kotak Dialog Crosstabs Statistics  

2. Analisis Hasil  

a. Hasil analisis crosstabs untuk kualitas pelayanan.  

Crosstab 

Count 

 
Pelayanan 

Total Puas Tidak Puas 

Market Indomaret 5 3 8 

Alfamart 8 2 10 

DeaMart 8 4 12 

Total 21 9 30 

 

Gambar 4.19 Hasil Pengolahan Crosstabs Kualitas Pelayanan   
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Chi-Square Tests 

 
Value df 

Asymp. Sig. (2-

sided) 

Pearson Chi-Square .754a 2 .686 

Likelihood Ratio .782 2 .676 

Linear-by-Linear 

Association 

.009 1 .923 

N of Valid Cases 30   

a. 3 cells (50,0%) have expected count less than 5. The minimum 

expected count is 2,40. 

 

Gambar 4.20 Hasil Pengolahan Chi-Square Kualitas Pelayanan  

Dari hasil di atas menunjukan bahwa Alfamart dan DeaMart lebih 

memuaskan konsumen daripada Alfamart untuk kualitas pelayanan 

yang diberikan.  

b. Hasil analisis crosstabs untuk harga terkait dengan harga produk yang 

tersedia  

Crosstab 

Count 

 
Harga 

Total Puas Tidak Puas 

Market Indomaret 6 2 8 

Alfamart 5 5 10 

DeaMart 8 4 12 

Total 19 11 30 

Gambar 4.21 Hasil Pengolahan Crosstabs Harga  

 

 

Chi-Square Tests 

 
Value df 

Asymp. Sig. (2-

sided) 

Pearson Chi-Square .108a 2 .948 

Likelihood Ratio .108 2 .947 

Linear-by-Linear 

Association 

.047 1 .829 

N of Valid Cases 30   

a. 3 cells (50,0%) have expected count less than 5. The minimum 

expected count is 2,93. 

Gambar 4.22 Hasil Pengolahan Chi-Square Harga  
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Dari hasil di atas menunjukan bahwa DeaMart lebih memuaskan 

konsumen dari pada Alfamart dan Indomaret untuk harga produk yang 

tersedia.  

c. Hasil analisis crosstabs untuk lokasi  

Crosstab 

Count 

 
Lokasi 

Total Puas Tidak Puas 

Market Indomaret 5 3 8 

Alfamart 6 4 10 

DeaMart 8 4 12 

Total 19 11 30 

Gambar 4.23 Hasil Pengolahan Crosstabs Lokasi  

 

 

Chi-Square Tests 

 
Value df 

Asymp. Sig. (2-

sided) 

Pearson Chi-Square .108a 2 .948 

Likelihood Ratio .108 2 .947 

Linear-by-Linear 

Association 

.047 1 .829 

N of Valid Cases 30   

a. 3 cells (50,0%) have expected count less than 5. The minimum 

expected count is 2,93. 

Gambar 4.24 Hasil Pengolahan Chi-Square Lokasi  

 

Dari hasil di atas menunjukan bahwa DeaMart memiliki lokasi lebih 

strategis untuk dijangkau oleh konsumen dibandingkan Indomaret dan 

Alfamart.  
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d. Hasil analisis crosstabs untuk fasilitas  

  

Crosstab 

Count 

 
Fasilitas 

Total Puas Tidak Puas 

Market Indomaret 6 2 8 

Alfamart 7 3 10 

DeaMart 8 4 12 

Total 21 9 30 

Gambar 4.25 Hasil Pengolahan Crosstabs Fasilitas  

 

 

Chi-Square Tests 

 
Value df 

Asymp. Sig. (2-

sided) 

Pearson Chi-Square .159a 2 .924 

Likelihood Ratio .161 2 .923 

Linear-by-Linear 

Association 

.151 1 .697 

N of Valid Cases 30   

a. 3 cells (50,0%) have expected count less than 5. The minimum 

expected count is 2,40. 

Gambar 4.26 Hasil Pengolahan Chi-Square Fasilitas  

 

Dari hasil di atas menunjukan bahwa fasilitas yang tersedia dan dapat 

dinikmati oleh konsumen lebih memuaskan fasilitas yang ada di 

DeaMart dibandingkan dengan fasilitas yang tersedia di Alfamart dan 

Indomaret. 

 

3.   Tugas Kelas 

  Lakukan analisis fasilitas Minimarket diatas dengan 50 konsumen! 

 

 

 

 

 

 

 

 

 



30  

  

LEMBAR KERJA PRAKTIKUM 

Nilai  Materi    NIM  
  

  

Tanggal    Nama  
  

Dosen    Kelas  
  

  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  

……………………………………………………………………………………….  

  



31  

  

BAB V UJI NORMALITAS DAN KESERAGAMAN DATA  

  

5.1 Kompetensi Dasar  

Kompetensi dasar yang harus dimiliki oleh mahasiswa setelah mempelajari uji 

normalitas dan keseragaman data adalah sebagai berikut:  

1. Mengetahui dan memahami jenis analisis statistik  

2. Dapat melakukan pengolahan data dengan uji kenormalan dan keseragaman 

data  

3. Mampu memahami dan mengambil kesimpulan dari hasil pengolahan 

dengan analisis statistik.  

  

5.2 Indikator  

Indikasi dari materi uji normalitas dan keseragaman data ini untuk mahasiswa 

adalah sebagai berikut:  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheet software SPSS  

4. Input data pada software SPSS  

5. Mempelajari penggunaan aplikasi analisis uji normal dan keseragaman data.  

  

5.3 Studi Kasus  

1. Entry Data  

Berikut merupakan data dari anggota grup lawak Three Stooges (Curly, Larry 

dan Moe) berdasarkan tingkat Brain Damage dan Stupidity Index yang 

dimiliki ketiga anggota tersebut. Kemudian akandigunakan untuk melakukan 

analisis menggunakan uji normalitas dan keseragaman data   

  

 
Gambar 5.1 Data Pengolahan Uji Normalitas dan Keseragaman Data  
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2. Analisis Data  

Untuk melakukan uji normalitas dan uji keseragaman data, langkah-langkah 

yang harus dilakukan adalah sebagai berikut:  

a. Pilihlah menu Analyze lalu pilih Descriptive Statistic selanjutnya pilih 

Explore kemudian akan muncul kotak dialog Explore.  

  

  

Gambar 5.2 Kotak Dialog Analyze  

  

b. Pindahkan variabel brain_damage dan stupidity_index ke kolom 

Dependent List dan variabel Favorite ke kolom Factor List  

  

 

Gambar 5.3 Kotak Dialog Explore  

  

c. Pilih Plots dan beri tanda centang pada Normality Plots with Test, 

kemudai Power Estimation yang terdapat pada ruang Spread vs Level 

with Levene Test kemudian pilih continue dan klik OK  
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Gambar 5.4 Kotak Dialog Explore Plots  

  

d. Hasil dari pengolahan data di atas adalah sebagai berikut:  

1. Test of Normality  

  

 
  

Gambar 5.5 Hasil Pengolahan Uji Normalitas dan Keseragaman 

Data  

  

Analisis hasil uji normalitas dilakukan dengan menggunakan nilai 

alpha (α) sebesar 0,05 sebagai alat ukur untuk menentukan data yang 

diolah termasuk kedalam data yang dikatakan normal atau tidak. 

Jika hasil signifikansi (Sig.) dari data yang diolah lebih besar dari 

nilai α, maka data tersebut termasuk data yang normal (Sig. >α), 

sedangkan jika nilai Sig. <α, maka data tersebut merupakan data 

yang tidak normal. Dari hasil di atas menunjukan bahwa   

a. Variabel brain_damage memiliki nilai sig. >α (0,200 > 0,05)  

b. Variabel stupidity_index memiliki nilai sig. >α (0,200 > 0,05)  

Maka kedua variabel tersebut dapat dikatakan data yang normal dan 

dapat dilakukan pengolahan selanjutnya.  

  

2. Hasil Uji Keseragaman Data  

Uji keseragaman data dapat dilakukan menggunakan uji statistik 

deskriptif dengan menambahkan tanda centang pada pengolahan 

Range. Berikut merupakan hasil pengolahan uji keseragaman data.  
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Descriptive Statistics  

  

N  Range  Minimum  Maximum  Mean  

Std. 

Deviation  

brain_damage  75  41  9  50  

64  

  

28.89  9.852 

stupidity_index  75  64  0  28.52  11.894 

Valid N (listwise)  75          

                         Gambar 5.6 Hasil Pegolahan Uji Keseragaman Data  

  

Dari hasil di atas untuk melakukan analisis uji keseragaman data 

digunakan hasil minimum, maximum dan range.   

a. Variabel barin_damage dengan nilai minimum 9, nilai maximum 

50 dan nilai range 41, maka dapat diketahui bahwa data tersebut 

adalah data yang seragam karena nilai range berada diantara nilai 

9 – 50.  

b. sVariabel stupidity_index dengan nilai minum 0, nilai maximum 

64 dan nilai range 64, maka dapat diketahui bahwa data tersebut 

adalah data yang seragam karena nilai range berada diantara nilai 

0 – 64.  

 3. Tugas Kelas 

      Berikut ini adalah data hasil survey dari 10 orang mengenai tingkat populer, 

berbakat, dan menarik dari personil the Beatles, lakukan uji normalitas dan uji 

keseragaman data. 

 

Keterangan: 

1-6 Nama personil dan nilai 1-10 untuk masing-masing tingkatan. 

Tabel 5.1 Keterangan Tugas Kelas 

Keterangan 

1= John Lennon 

2= Paul McCartney 

3=George Harrison 

4= Ringo Starr 

5= Stuart Sutcliffe 

6= Pete Best 
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Tabel 5.2 Hasil Survey the Beatles 

No Anggota Populer Berbakat Menarik 

1 1 8 2 6 

2 1 10 8 8 

3 1 8 7 8 

4 1 2 9 2 

5 1 8 1 1 

6 1 3 10 2 

7 1 2 2 5 

8 1 2 4 6 

9 1 3 8 4 

10 1 2 1 1 

11 2 2 8 3 

12 2 3 10 8 

13 2 5 5 1 

14 2 10 3 2 

15 2 10 6 3 

16 2 3 7 5 

17 2 7 3 3 

18 2 3 4 5 

19 2 3 9 10 

20 2 8 2 6 

21 3 1 8 9 

22 3 6 6 8 

23 3 1 1 10 

24 3 7 3 5 

25 3 4 1 6 

26 3 6 2 10 

27 3 4 4 1 

28 3 8 6 4 

29 3 4 8 10 

30 3 1 1 8 

31 4 3 2 9 

32 4 7 1 1 

33 4 2 4 3 

34 4 5 9 9 

35 4 3 7 2 

36 4 7 8 10 

37 4 5 1 8 

38 4 3 1 10 

39 4 8 4 2 



36  

  

No Anggota Populer Berbakat Menarik 

40 4 4 8 2 

41 5 9 10 5 

42 5 10 5 2 

43 5 6 5 5 

44 5 6 6 7 

45 5 10 8 2 

46 5 3 7 9 

47 5 3 3 2 

48 5 2 3 6 

49 5 4 7 2 

50 5 4 3 3 

51 6 4 10 2 

52 6 1 6 7 

53 6 7 2 9 

54 6 4 7 8 

55 6 2 6 2 

56 6 5 5 1 

57 6 6 8 4 

58 6 3 5 1 

59 6 2 8 10 

60 6 4 4 3 
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BAB VI UJI RELIABILITAS DAN VALIDITAS  

  

6.1 Kompetensi Dasar  

Kompetensi dasar yang harus dimiliki oleh mahasiswa setelah mempelajari uji 

reliabilitas dan valididtas adalah sebagai berikut:  

1. Mengetahui dan memahami jenis analisis statistik  

2. Dapat melakukan uji validitas dan reliabilitas pada data  

3. Mampu memahami dan mengambil kesimpulan dari hasil pengolahan 

dengananalisis statistik.  

  

6.2 Indikator  

Indikasi dari materi uji reliabilitas dan validitas ini adalah sebagai berikut:  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheet software SPSS  

4. Input data pada software SPSS  

5. Mempelajari penggunaan aplikasi analisis statistik uji validitas dan 

reliabilitas  

  

6.3 Landasarn Teori  

 Uji validitas dan realiabilitas biasanya digunakan untuk menguji penelitian 

yangmenggunakan kuisioner dalam pengambilan datanya. Uji validitas adalah 

pengujian yangdilakukan guna untuk mengetahui seberapa cermat suatu 

instrument dalam mengukur apa yang ingin diukur, sedangkan uji reliabilitas 

yaitu untuk menguji konsistensi alat ukur, apakah hasilnya tetap konsisten jika 

pengukuran diulang. Item kuisioner yang tidak valid berarti tidak dapat 

mengukur apa yang ingin diukur sehingga hasil yang didapat tidak 

dapatdipercaya, sehingga item yang tidak valid harus dibuang atau diperbaiki. 

Sedangkan instrument kuisioner yang tidak reliabel maka tidak dapat konsisten 

untuk pengukuran sehingga hasil pengukuran tidak dapat dipercaya.  

 Tingkat reliabilitas dari pengujian dengan metode alpha cronbach diukur 

berdasarkan skala alpha 0 sampai dengan 1. Apabila skala tersebut 

dikelompokkan ke dalam lima kelas range yang sama, maka ukuran reliabilitas 

alpha dapat diinterpretasikan seperti pada tabel berikut.   
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Tabel 6.1 Tingkat Reliabilitas  

Alpha Cronbach  Tingkat Reliabilitas  

0,00-0,20  Kurang Reliabel  

0,201-0,40  Agak Reliabel  

0,401-0,60  Cukup Raliabel  

0,601-0,80  Reliabel  

0,801-1,00  Sangat Reliabel  

  

6.4 Studi Kasus  

1. Entry Data  

Berikut merupakan contoh data hasil pengisian kuesioner kepuasan 

pelayanan bagian operasional kampus 1 UTY terhadap 19 responden 

(mahasiswa). kuesioner berisi 10 pernyataan terkait dengan pelayanan yang 

dilakukan oleh karyawan di bagian operasional, kemudan dilakukan 

penilaian dengan 5 kriteria sebagai berikut:  

1 = Kurang Setuju  

2 = Cukup Setuju  

3 = Setuju  

  

Tabel 6.2. Data Uji Validitas dan Reliabilitas  

Responden  

Bentuk 

dan  
Tampilan  

Fitur  Kecepatan  Varian  

1  1  1  2  1  

2  3  2  2  1  

3  3  2  1  1  

4  3  2  3  1  

5  2  3  3  2  

6  1  1  1  3  

7  1  2  3  1  

8  1  1  2  1  

9  2  1  1  3  

10  2  1  3  1  

11  1  3  3  3  

12  1  1  3  3  

13  1  3  1  3  

14  2  1  3  2  
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Responden  

Bentuk 

dan  
Tampilan  

Fitur  Kecepatan  Varian  

15  2  2  1  1  

16  3  2  1  2  

17  3  2  1  1  

18  1  1  2  2  

19  2  3  1  1  

20  2  1  3  2  

21  2  3  3  1  

22  2  2  2  3  

23  3  2  3  2  

24  2  1  1  1  

25  3  2  1  1  

26  3  2  2  2  

27  3  1  1  3  

28  1  2  1  1  

29  2  3  3  3  

30  1  2  1  3  

31  2  2  1  2  

32  2  3  2  3  

33  2  3  3  2  

34  2  1  2  3  

35  1  3  3  3  

36  3  3  3  1  

37  3  3  3  1  

38  1  2  2  1  

39  3  1  2  1  

40  2  2  3  3  

41  1  2  3  3  

42  1  2  1  2  

43  1  3  3  2  

44  2  3  2  3  

45  2  3  1  2  

46  3  1  3  3  
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Responden  

Bentuk 

dan  
Tampilan  

Fitur  Kecepatan  Varian  

47  2  2  3  1  

48  2  1  1  3  

49  3  1  3  3  

50  1  3  1  3  

  

  

2. Analisis Hasil  

Berikut merupakan langkah-langkah dan analisis hasil dari pengolahan uji 

reliabilitas dan validitas menggunakan SPSS16:  

a. Menggunakan Corerlation Product Moment untuk menguji validitas  

b. Menjumlahkan data yang akan di uji dengan menggunakan Transform 

kemudian pilih Compute lalu pilih variabel yang akan dijumlahkan dan 

ketik nama variabel yang menjadi tujuan (Total) lalu klik OK  

  

 

Gambar 6.1 Kotak Dialog Transform  
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  Gambar 6.2 Kotak Dialog Compute Variable  

  

c. Lakukan korelasi denganc ara pilih Analyze  lalu pilih Corelate 

kemudian pilih Bivariate dan pilih Pearson Corelation dan masukan 

smeua variabel yang akan diuji (termasuk variabel N Total) kedalam 

kotak variabel (s) lalu klik OK  

  

  

 

  

Gambar 6.3 Kotak Dialog Analyze  

  

d. Berikut merupakan hasil dari uji validitas terhadap hasil kuesioner 

dengan 50 responden dari 4 pernyataan.  
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Gambar 6.4 Hasil Uji Validitas  

  

Untuk menentukan hasil dari uji validitas bahwa data yang di uji valid 

atau tidak valid dilakukan berdasarkan jumlah pernyataan atau 

pertanyaan yang digunakan dalam kuesioner, dalam hal ini terdapat 4 

(N=4) dengan tingkat signifikan 5% pada tabel r dengan rumus df=N-2 

= 4-2= 2, maka nilai df=0,5494 yang dibandingkan dengan hasil 

Pearson Corelationpada kolom Ntotal untuk masing-masing 

pernyataan. Maka dari hasil uji Validitas di atas dapat dijelaskan sebagai 

berikut:  

Bentuk dan Tampilan = 0,067 < 0,9500  tidak valid  

 Fitur     = 0,248 > 0,9500 tidak valid  

 Kecepatan     = 0,126 < 0,9500 tidak valid  

 Varian     = 0,348 < 0,9500 tidak valid  

  

e. Untuk mengetahui reliabilitas hasil kesioner tersebut, langkah-langkah 

yang dilakukan adalah memilih Analyze lalu Scale kemudian pilih 

Reliability Analysis  
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Gambar 6.5 Kotak Dialog Analyze  

  

f. Masukan semua variabel yang akan di uji (tidak termasuk variabel total), 

kemudian pilih Statistic pilih Scale dan Scale if Item Deleted  

kemudain pilik Continue dan OK  

  

  

Gambar 6.6 Kotak Dialog Raliability Analysis dan RaliabilityAnalysis Statistics  

  

g. Kemudian akan muncul hasi output sebagai berikut  

Reliability Statistics  

Cronbach's  

Alphaa  
N of Items  

-.079  4  
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a. The value is negative due to 

a negative average covariance 

among items. This violates 

reliability model assumptions. 

You may want to check item 

codings.  

  

Gambar 6.7 Hasil Nilai Cronbach’s Alpha  

  

Berdasarkan Reliability Statistic terlihat bahwa nilai Cronbach's Alpha 

adalah -0,079 pada 4 N of Items pernyataan. Nilai tersebut berada di 

bawah range0,00 – 0,20 yang artinya bahwa pertanyaan kurang reliabel.  

 

3.   Tugas Kelas 

    Lakukan uji validitas dan reabilitas data penilaian dari ruang tunggu dalam 

rumah sakit berikut dan berikan hasil analisismu. 

Tabel 6.3 Hasil Pengumpulan Data Rumah Sakit 

Responden Kelembaban Pencahayaan Kenyamanan Kebisingan 

1 2 3 1 1 

2 3 3 1 3 

3 3 2 1 3 

4 2 2 1 2 

5 3 2 1 3 

6 2 1 3 3 

7 1 1 3 1 

8 2 1 2 1 

9 2 1 3 3 

10 3 2 1 2 

11 2 3 3 2 

12 3 2 2 2 

13 1 2 2 2 

14 1 2 1 1 

15 2 2 3 3 

16 3 2 1 1 

17 1 3 1 3 

18 2 3 1 1 

19 2 1 2 3 

20 3 1 1 3 

21 3 2 1 1 

22 3 2 2 3 

23 1 3 1 2 

24 3 3 1 2 



47  

  

Responden Kelembaban Pencahayaan Kenyamanan Kebisingan 

25 1 3 1 2 

26 1 3 1 2 

27 1 3 3 3 

28 3 2 1 3 

29 2 3 1 3 

30 2 2 3 2 

31 3 3 3 1 

32 3 2 3 1 

33 3 2 2 1 

34 1 2 2 2 

35 2 1 1 3 

36 2 2 3 3 

37 3 1 1 2 

38 3 1 2 1 

39 1 3 2 1 

40 2 3 1 2 

41 2 1 3 3 

42 1 3 1 1 

43 2 1 3 1 

44 2 2 2 2 

45 3 2 2 3 

46 2 2 1 1 

47 2 3 2 1 

48 1 2 3 2 

49 2 1 2 2 

50 1 1 3 1 
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LEMBAR KERJA PRAKTIKUM  

Nilai  Materi    NIM  
  

  

Tanggal    Nama  
  

Dosen    Kelas  
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BAB VII STATISTIK PARAMETRIK  

  

7.1 Kompetensi Dasar  

Kompetensi dasar yang harus dimiliki oleh mahasiswa setelah mempelajari 

statistik parametrik adalah sebagai berikut:  

1. Mengetahui dan memahami jenis analisis statistik  

2. Dapat melakukan berbagai uji dalam statistik parametrik  

3. Mampu memahami dan mengambil kesimpulan dari hasil pengolahan 

dengan analisis statistik.  

  

7.2 Indikator   

Indikasi dari materi uji parametrik ini untuk mahasiswa adalah sebagai berikut:  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheet software SPSS  

4. Input data pada software SPSS  

5. Mempelajari penggunaan aplikasi analisis statistik parametric  

7.3 Landasan Teori  

Uji statistik dapat dikelompokkan ke dalam 2 desain dasar penelitian, yaitu 

desainbetween subject dan within subject. Berikut ini pengelompokkan uji 

parametrik dalamSPSS dengan desain penelitian.  

Tabel 7.1 Uji Parametrik dalam SPSS 

Desain  Uji Parametrik dalam SPSS  

Within Subject  One Sample T-Test  

Between Subject  Independet Sample T-Tes  

Within Subject  Paired Sample T-Test  

Between Subject  One way ANOVA, analisis varian untuk satu variabel 

independent   

Between Subject  General linier model-univariate, analisis varian untuk 

dua atau lebih variabel independent  

Gabungan antara 
Within Subject 

dengan Between  

Subject  

General linier model-repeated measure, menganalisis 

varian dengan melakukan pengukuran yang sama 

beberapa kali pada setiap subject/cases/variabel within 

subject. Apabila melibatkan variabel tersebut akan 

membagi populasi menjadi beberapa kelompok  

1. One Sample T-Test  

One sample T-test digunakan untuk menguji perbedaan rata-rata suatu 

sample dengan suatu nilai hipotesis.  
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Pengujian rata-rata satu sampel dimaksudkan untuk menguji nilai tengah 

atau rata-rata populasi µ sama dengan nilai tertentu µ 0, lawan hipotesis 

alternatifnya bahwa nilai tengah atau rata-rata populasi µ tidak sama dengan 

µ0, jadi jika akan menguji:  

Ho: µ = µ o lawan H1: µ # µ o, Ho merupakan hipotesis awal.  

Berikut merupakan data jumlah produksi berdasarkan pada tingkat 

pendidikan karyawan (1=SMK, 2=SMA) dan jumlah pesanan dari 

konsumen pada bulan Juni.  

Tabel 7.2 Data Uji One Sample T test  

Pendidikan 

Terakhir  

Jumlah 

Produksi  

Jumlah 

Pesanan  

1  347  265  

1  336  279  

1  351  299  

2  331  279  

2  313  262  

2  307  282  

2  301  277  

2  306  294  

2  336  273  

2  304  290  

2  317  284  

2  325  283  

2  350  286  

2  308  266  

1  305  300  

1  350  288  

1  311  285  

2  333  288  

2  302  266  

2  318  272  

2  304  267  

1  326  262  

1  350  294  

1  328  285  

2  334  272  
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Pendidikan 

Terakhir  

Jumlah 

Produksi  

Jumlah 

Pesanan  

2  305  289  

1  314  273  

1  310  273  

1 345 288 

2 362 264 

  

Langkah-langkah dalam melakukan ujian one T-test adalah sebagai berikut:  

a. Input data ke dalam SPSS  

b. Klik Analyze→ Compare Means →One Sample T Test  

  

Gambar 7.1 Kotak Dialog One Sample T test  

c. Masukkan variabel jumlah produksi Ke dalam kotak test variabel dan 

masukkan nilai 100 di kotak test value.  

d. Klik Options, maka kotak dialog one sample T test: options muncul. 

Tingkat kepercayaan 95% dan exclude case by analysis by analysis 

terpilih secara default.  

Missing values _ exclude case analysis by analysis berarti hanya data 

yang berharga valid yang digunakan dalam analysis.  

  

Gambar 7.2 Kotak dialog one sample T test: options  

e. Klik continue  

f. Klik OK  

g. Hasil Pengolahan One Sample T-Test  
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Tabel 7.3 Hasil Uji One Sample T-Test 1 

One-Sample Statistics 

 N Mean Std. Deviation Std. Error Mean 

Jumlah_Produksi 30 324.30 18.366 3.353 

 

Tabel 7.4 Hasil Uji One Sample T-Test 2 

One-Sample Test 

 

Test Value = 0                                        

t df Sig. (2-tailed) 

Mean 

Difference 

95% Confidence Interval of the 

Difference 

Lower Upper 

Jumlah_Produksi 96.713 29 .000 324.300 317.44 331.16 

Untuk mengetahui hasil uji One-Sampe T-Test dilakukan melalui 

beberapa tahapan, yaitu:  

1. Penentuan hipotesis (H0 dan H1)  

H0: µ = rata-rata jumlah produk yang dihasilkan pada bulan Juni 

sama dengan 324,30 unit.  

H1: µ ≠ rata-rata jumlah produk yang dihasilkan pada bulan Juni 

tidak sama dengan 324,30 unit  

2. Tingkat signifikan (α) 5%  

3. Daerah kritis: jika t hitung > t tabel, maka tolak H0, jika t hitung < 

α, maka tolak H0  

4. Uji statistik: sig.= 0,000; t hitung= 96,713; t tabel = 2,04523 Maka t 

hitung > t tabel = 96,713> 2,04523 

5. Keputusan: karena nilai sig. (2-tailed) < α dan t hitung > t tabel, 

maka tolak H0  

6. Kesimpulan: jadi dengan tingkat signifikansi 5%, didapatkan 

kesimpulan bahwa rata-rata jumlah unit yang diproduksi pada bulan 

Juni tidak sama dengan 324,30 unit.  

3.   Tugas Kelas  

      Lakukan pengujian ulang terhadap data tabel 7.2 dengan tambahan 10 

responden dari lulusan SMK 
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56  

  

2. Independent Sample T Test  

Independent Sample T Test digunakan untuk menguji signifikansi beda rata-

rata dua kelompok data dua kelompok data atau sampel yang independent.  

Misalkan anda melakukan pengamatan apakah ada perbedaan rata-rata 

jumlah produksi jarum suntik pada PT Sejahtera dibulan Januari berdasarkan 

tingkat pendidikan pekerja. Dalam beberapa hari dilakukan pengambilan data 

berikut:  

Tabel 7.5 Data Uji Independent Sample T-Test  

Nama  Jenis  

Kelamin  

Pendidikan 

Terakhir  

Jumlah  

Produksi 

(unit)  

Jumlah  

Lembur  

(unit)  

Adi  Laki-laki  SMK  100  1000  

Alif  Laki-laki  SMA  130  1300  

Seli  Perempuan  SMK  110  1100  

Aan  Laki-laki  PT  100  1000  

Latif  Laki-laki  SMA  110  1100  

Siti  Perempuan  SMA  105  1050  

Devi  Perempuan  SMK  150  1500  

Dea  Perempuan  SMK  190  1900  

Roni  Laki-laki  SMK  200  2000  

Roif  Laki-laki  SMA  160  1600  

Diva  Perempuan  SMA  150  1500  

Danu  Laki-laki  SMA  100  1000  

Darwin  Laki-laki  PT  120  1200  

Dono  Laki-laki  PT  140  1400  

Ema  Perempuan  SMK  200  2000  

  

Langkah-langkah dalam melakukan uji independent sample T test adalah 

sebagai berikut:  

a. Input data ke dalam SPSS  

b.  Klik Analyze→ Compare Means →Independent Sample T Test  

   

Gambar 7.3 Kotak Dialog Independent Sample T Test  
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c. Masukkan variabel test yaitu Jumlah Produksi ke kotak test 

variable(s) dan masukkan variabel Jenis Kelamin ke kotak grouping 

variable.  

d. Klik define groups, maukkan nilai value variabal jenis kelamin di 

kotak group 1 dan 2.  

  

Gambar 7.4 Kotak dialog define groups  

e. Klik continue  

f. Klik options, maka kotak dialog independent sample T tes: options 

muncul. Tingkat kepercayaan 95% dan exclude cases analysis by 

analysis terpilih secara default.  

  

Gambar 7.5 Kotak Dialog Independent Sample T Test: Options  

g. Klik continue  

h. Klik OK  

i. Hasil Pengolahan Uji Independent Sampe T Test  
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Tabel 7.6 Hasil Uji Independent Sample T-Test 

Independent Samples Test  

    

    

Levene's Test for 

Equality of Variances  

  

t-test for Equality of Means  

F  Sig.  t  df  

Sig.  

(2tailed)  
Mean  

Difference  
Std. Error 

Difference  

95% Confidence  

Interval of the  

Difference  

           Lower  Upper  

Jumlah_Pr Equal 

oduksi  variances  

assumed  

Equal 

variances not 

assumed  

.130  .724  -1.158  13  .268  -21.944  18.952  -62.888  18.999 

    

-1.120  9.656  .290  -21.944  19.586  -65.796  21.907 

Untuk mengetahui hasil uji Independent Sample T Test dilakukan 

melalui beberapa tahapan, yaitu: 1. Penentuan hipotesis (H0 dan H1)  

H0: tidak terdapat perbedaan pada jumlah produksi jarum suntik di 

bulan Januari pada PT Sejahtera berdasarkan tingkat 

pendidikan terakhir pekerja.  

H1: terdapat perbedaan pada jumlah produksi jarum suntik di bulan 

Januari pada PT Sejahtera berdasarkan tingkat pendidikan 

terakhir pekerja.  

2. Tingkat signifikan (α) 5%  

3. Daerah kritis: jika sig. (2-tailed) >α, maka terima H0 jika sig. (2-

tailed) < α, maka tolak H0  

4. Uji statistik: sig.(2-tailed) = 0,724; α= 0,05 Maka sig. (2-tailed) >α 

= 0,724 > 0,05  

5. Keputusan: karena nilai sig. (2-tailed) > α maka terima H0  

6. Kesimpulan: jadi dengan tingkat signifikansi 5% dapat disimpulkan 

bahwa tidak terdapat perbedaan jumlah produksi jarum suntik 

dibulan Januari di PT Sejahtera berdasarkan tingkat pendidikan 

terakhir pekerja  
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  Tugas Kelas 

Lakukan pengujian ulang terhadap tabel 7.5 dengan tambahan data berikut: 

Nama  Jenis  

Kelamin  

Pendidikan 

Terakhir  

Jumlah  

Produksi 

(unit)  

Jumlah  

Lembur  

(unit)  

Sandra  Perempuan PT  200 1050 

Ana Perempuan SMA  202 1000 

Sinta Perempuan  SMK  205 998 

Supri Laki-laki  SMK 199 1011 

Indra Laki-laki  SMA  200 1005 

Joko Laki-laki  PT 210 1115 

Lila  Perempuan  SMK  220 1002 

Rina  Perempuan  SMK  240 1000 

Rois  Laki-laki  PT  199 989 

Lutfi  Laki-laki  SMA  200 1023 
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3. Paired Sample T Test  

Paired sample T test adalah dua pengukuran pada subject yang sama (desain 

within subject) terhadap suatu pengaruh atau perlakuan tertentu. Ukuran 

sebelum dan sesudah mengalami perlakuan di ukur.  

Paired sample T Test atau uji sampel berpasangan digunakan untuk menguji 

perbedaan rata-rata dari dua kelompok data atau sampel yang berpasangan.  

Misalnya anda melakukan pengamatan di bagian produksi meja terhadap 

operator mesin bor yang sudah mengalami pelatihan dan belum mengalami 

pelatihan. Penilaian dilakukan dalam kinerja peningkatan jumlah produksi/hari. 

Diambil sampel selama 1 hari. Berikut ini adalah data hasil penelitiannya:  

Tabel 7.7 Data Uji Paired Sample T-Test  

Sebelum Pelatihan  Sesudah Pelatihan  

100  105  

80  100  

99  105  

100  106  

120  109  

110  99  

99  98  

80  120  

108  100  

199  106  

99  108  

106  103  

107  100  

105  108  

100  104  

Uji paired sample T test dapat dilakukan dengan langkah-langkah sebagai 

berikut:  

a. Input data di atas ke dalam SPSS  

b. Klik Analyze → Compare Means → Paired Sample T Test  
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Gambar 7.6 Kotak Dialog Paired Sample T Test  

c. Blok variabel sebelum dan sesudah sehingga variabel tersebut keblok 

semua kemudian pindah ke kotak paired variable (s) dengan 

melakukan klik tombol panah.  

d. Klik options, maka kotak dialog options: paired sample T test  

muncul. Tingkat kepercayaan 95% dan exclude cases analysis by 

analysis terpilih secara default.  

  

Gambar 7.7 Kotak Dialog Paired Sample T Test:Options  

e. Klik continue  

f. Klik OK  

g. Hasil uji Paired Sample T Test  

Tabel 7.8 Hasil Uji Sample T Test:Options 

Paired Samples Test  

    

    

    

Paired Differences  

t  df  

Sig.  

(2tailed)  Mean  
Std. 

Deviation  

Std. Error  

Mean  

95% Confidence 

Interval of the 

Difference  

Lower  Upper  

Pair 1 sebelum_ 

pelatihan  

-  

sesudah_ 

pelatihan  2.733  28.164  7.272  -12.863  18.330  .376  14  .713 
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Untuk mengetahui hasil uji Paired Sample T Test dilakukan melalui 

beberapa tahapan, yaitu:  

1. Penentuan hipotesis (H0 dan H1)  

H0: rata-rata jumlah produksi yang dihasilkan operator sebelum dan 

sesudah pelatihan mesin bor adalah sama  

H1: rata-rata jumlah produksi yang dihasilkan operator sebelum dan 

sesudah pelatihan mesin bor adalah berbeda  

2. Tingkat signifikan (α) 5%  

Daerah kritis: jika t hitung > t tabel, maka tolak H0  

   jika t hitung < t tabel, maka terima H0  

3. Uji statistik: nilai t hitung= 0,376; nilai t tabel= 1,76131 Maka t 

hitung < t tabel = 0,376 > 1,76131  

4. Keputusan: karena nilai t hitung < t tabel, maka terima H0  

5. Kesimpulan: jadi dengan tingkat signifikansi 5% dapat disimpulkan 

bahwa rata-rata jumlah produksi yang dihasilkan operator sebelum 

dan sesudah pelatihan mesin bor adalah sama.  

Tugas Kelas 

Lakukan pengujian kembali apabila ditambah 10 karyawan tambahan dalam 

pelatihan berikut 

Sebelum Pelatihan  Sesudah Pelatihan  

110 250 

105 249 

150 285 

109 269 

111 295 

109 225 

145 255 

135 260 

150 270 

128 235 
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4. One Way ANNOVA  

Analisis varian satu variabel independent digunakan untuk menentukan atau 

menguji apakah rata-rata du atau lebih kelompok berbeda secara nyata.  

Misalkan anda akan melakukan pengamatan pengaruh pengalaman kerja 

dengan kinerja jumlah produksi/hari pleh karyawan yang sudah bekerja 1 dan 

2 tahun. Data yang dihasilkan sebagai berikut: 

Keterangan 1=SD, 2=SMP, 3=SMA, 4=D1, 5=D2, 6=D3, 7=D4, 8=S1, 

9=S2, dan 10=S3. 

Tabel 7.9 Data Uji One Way ANNOVA  

Tahun  

Pendidikan  
Terakhir Yang 

Ditamatkan  

Angkatan 

Kerja  

1  1  4923639  

1  2  18151754  

1  3  31533029  

1  4  21472821  

1  5  19804914  

1  6  11799733  

1  7  3140091  

1  8  10020840  

1 9 23567890 

1 10 45219072 

2  1  4300140  

2  2  15653745  

2  3  32478422  

2  4  21481275  

2  5  20671183  

2  6  12376565  

2  7  3202427  

2  8  10483940  

2 9 29102839 

2 10 18792039 

  

Analisis varian untuk satu variabel independent dapat dilakukan sebagai 

berikut:  

a. Input data di atas ke dalam SPSS  
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b. Klik Analyze → Compare Means → One Way ANNOVA  

  

Gambar 7.9 Kotak Dialog One Way Annova  

c. Masukkan variabel jumlah produksi ke kotak dependents list dan 

masukkan variabel pengalama kerja ke kotak factor.  

d. Klik options dan pilih Descriptive dan Homogenity of Variance test.  

  

Gambar 7.10 Kotak Dialog One Way Annova: Options  

e. Klik Continue  

f. Klik OK  

Tugas Kelas 

Lakukan analisis apabila ditambah dengan tahun ke 3 dan ke 4 di seluruh jenjang 

dengan rata-rata Angkatan kerja 2000000-2500000 setiap tahunnya 
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BAB VIII STATISTIK NON PARAMETRIK  

  

8.1 Kompetensi Dasar  

Kompetensi dasar yang harus dimiliki oleh mahasiswa setelah mempelajari 

statistik non parametrik ini adalah sebagai berikut:  

1. Mengetahui dan memahami jenis analisis statistik  

2. Dapat melakukan berbagai uji dalam statistik non parametrik  

3. Mampu memahami dan mengambil kesimpulan dari hasil pengolahan 

dengananalisis statistik.  

  

8.2 Indikator   

Indikasi dari materi statistik non parametrik ini adalah sebagai berikut:  

1. Mempelajari penggunaan Software SPSS  

2. Mempelajari cara penggunaan menu dan fungsi software SPSS  

3. Mempelajari pengaturan worksheet software SPSS  

4. Input data pada software SPSS  

5. Mempelajari penggunaan aplikasi analisis statistik non parametric  

  

8.3 Landasarn Teori  

 Uji statistik parametrik dilakukan di sampel terdistribusi normal. Apabila 

persyaratan tidak terpenuhi, maka terjadi penyimpangan data analisis menjadi 

tidak valid. Syarat uji statistik non parametric lebih longgar, yaitu tidak 

berdasarkan distribusi sampel sehingga uji ini sering disebut uji bebas distribusi. 

Uji statistik non parametrik yang dibahas pada modul iini adalah Chi Square, 1-

Sample K-S: One sample Kolmogorov Smirnov, Two independent Sample 

Test, K- Independent Smple Test, Two Related Samples.  

  

8.4 Kegiatan Praktikum  

1. Chi Square  

Prosedur test Chi Square untuk menguji suatu variabel bardasarkan kategori 

(analysis by categorical). Uji chi square suatu variabel atau chi square 

goodness fit test (uji khi kuadrat untuk kebebasan).  

  

2. Uji Chi Square Test satu variabel  

Digunakan untuk menguji apakah frekuensi data yang diamati dari suatu 

variabel kategorik sesuai dengan frekuensi harapan (expected frequencies).  

  

3. Uji Chi Square Test Satu Variabel dengan Frekuensi Harapan Sama 

Misalnya produsen baju mengeluarkan 6 model baju baru. Diharapkan 
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keenam model baju tersebut memiliki tingkat jual yang sama (H0), setelah 

setengah tahun dilakukan pengamatan terhadap penjual 10 model tersebut. 

Berikut ini data penjualan baju tersebut di periode awal penjualan:  

Tabel 8.1 Data Uji Chi Square Test satu variabel  

Model  Jumlah  

Model 1  75  

Model 2  88  

Model 3  89  

Model 4  110  

Model 5  100  

Model 6  120  

Model 7 100 

Model 8 130 

Model 9 150 

Model 10 125 

  

Langkah-langkah uji Chi Square satu variabel adalah sebagai berkut: a. 

Input data di atas ke dalam SPSS  

b. Klik Data → Weight Cases  

  

Gambar 8.1 Kotak Dialog Weight Cases  

c. Pilih Weight cases by dan masukkan variable jumlah terjual di dalam 

kotak frequency variable  

d. Klik OK  
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e. Klik Analysis → Non Parametrik Test → Chi Square  

  

Gambar 8.2 Kotak Dialog Chi Square Test  

f. Masukkan variabel model ke kotak test variable list, pilih get from 

data di kotak expected range dan pilih all categories equal di kotak 

expected values.  

g. Klik OK  

Tugas Kelas 

Lakukan pengujian ulang dan analisis terhadap tambahan data dari table 8.1 berikut. 

Model  Jumlah  

Model 11 95 

Model 12 110 

Model 13 100 

Model 14 120 

Model 15 116 

Model 16 119 

Model 17 120 

Model 18 99 

Model 19 100 

Model 20 105 

Model 21 120 
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Model 22 115 

Model 23 99 

Model 24 105 

Model 25 109 

Model 26 120 

Model 27 115 

Model 28 110 

Model 29 115 

Model 30 120 
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4. Uji Chi Square Test Satu Variabel dengan frekuensi Harapan Berbeda   

Pabrik pembuatan bubuk jahe menyatakan dalam setiap kantong kemasanya 

1000 gram terdapat 30% warna coklat,20% kemasan warna hijau, 20% warna 

merah, 20% warna kuning, dan 10% warna biru. Seorang konsumen membeli 

1 kemasan bubuk jahe tersebut dan di dalamnya terdapat 100 kemasan bubuk 

jahe dengan rincian warna sebagai berikut; 30 warna coklat, 20 warna hijau, 

15 warna merah, 20 warna kuning, dan 15 warna biru. Gunakan taraf 

signifikan α=0,01, untuk menguji apakah distribusi warna kemasan bubuk 

jahe sesuai dengan pernyataan pabrik.  

Langkah-langkah uji Chi Square satu variabel dengan frekuensi harapan 

berbeda adalah sebagai berikut:  

Tabel 8.2 Data Uji Chi Square Test satu variabel dengan frekuensi harapan 

berbeda  

Warna permen  Jumlah warna  Harapan  

Coklat  30  30% x 100 = 30  

Hijau   20  20% x 100 = 20  

Merah  15  15% x 100 = 15  

Kuning  20  20% x100= 20  

Biru  10  10% x 100 = 10  

Putih 5 5% x 100 = 5 

Total  100    

a. input data di atas ke dalam SPSS  

Keterangan: variabel warna kemasan bubuk jahe diberi value: 1 = coklat; 

2 = hijau; 3 = merah; 4 = kuning; 5 = biru, dan 6=putih.  
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b. Klik Data → Weight Case  

  

Gambar 8.3 Kotak Dialok Weight Case  

c. Klik OK  

d. Klik Analyze → Non Parametric Test → Chi Square Test   

  

Gambar 8.4 Kotak Dialog Chi Square Test  

e. Masukkan variable warna kemasan kedalam kotak Test Variable List. 

Pada kolom expected range pilih get from data dan pada kotak 

expected values pilih values.  

f. Klik OK.  

Tugas Kelas 

Lakukan pengyjian ulang dan analisis terhadap tabel 8.2 apabila terjadi tambahan 3 

warna dengan total 150 
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5. Uji Chi Square Dua Variable  

Uji chi square dua variable atau sering disebut uji chi square (𝑋2) untuk 

kebebasan (chi-square (𝑋2) test for independence) atau disebut juga 

contingency-table analysis digunakan untuk menguji apakah dua variabel 

kategorik bersifat independen atau dependen.  

Seorang manajer produksi sedang meneliti apakah banyaknya produk cacat 

atau tidak cacat tergantung dari umur seorang pekerja. Sampel diambil dari 

100 unit produk yang diproduksi selama satu bulan. Hasil dari pengambilan 

semple disajikan pada data di baawah ini:  

Tabel 8.3 Data Uji Chi Square Dua Variable  

Produk  Kelompok Usia (tahun)   

18 – 30  31 – 35  36 – 45  

Cacat  10  40  15  

Tidak cacat  30  40  15  

Apakah data di atas menunjukkan bahwa banyaknya produk cacat atau tidak 

tergantung pada usia pekerja? Gunakan α=0,05.  

Langkah-langkah uji Chi Square dua variabel adalah sebagai berikut:  

a. Input data di atas ke dalam SPSS  

Tabel 8.4 Data Uji Chi Square Dua Variable  

Produk  Usia  Frekuensi  

Cacat  18 – 30  10  

Cacat  31 – 35  40  

Cacat  36 – 45  15  

Tidak cacat  18 – 30  30  

Tidak cacat  31 – 35  40  

Tidak cacat  36 – 45  15  
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b. Klik Data → Weight Case  

  

Gambar 8.5 Kotak Dialok Weight Case  

c. Pilih weight case by, masukkan variabel frekuensi ke dalam kotak 

frequency variable  

d. Klik Analyze → Descriptive Statistic → Crosstabs  

  

Gambar 8.6 Kotak Dialog Crosstabs  

e. Masukkan variabel Produk pada kotak Row(s), variabel Usia pada 

kotak Colom(s).  

f. Klik Cells, pilih observed dan expected pada kotak dialog counts  
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Gambar 8.7 Kotak Dialog Crosstabs: Cell Display  

g. Klik Continue, maka kembali ke kotak Crosstabs  

h. Klik Statistic, maka muncul kotak dialog crosstabs: statistic  

  

Gambar 8.8 Kotak Dialog Crosstabs: Statistic  

i. Beri tanda centang chi square dan klik continue  

j. Klik OK  

Tugas Kelas 

Lakukan pengujian ulang dan analisis apabila ditambahkan rentang usia 46-55 

dan 56-65 dengan frekuensi 25 
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6. 1-Sample K-S: One Sample Kolmogorov Smirnov  

One sample Kolmogorov Smirnov digunakan untuk menguji nul hipotesis 

suatu sampel tentang suatu distribusi tertentu. Uji ini dilakukan dengan 

menemukan perbedaan terbesar (nilai absolute) antara dua fungsi distribusi 

kumulatif, yaitu distribusi yang berasal dari data dan distribusi secara teori 

matematika. Terdapat empat macam distribusi yaitu normal, uniform, 

poisson dan eksponensial. Dengan menggunakan data pada analisis 

frequency.  

Langkah-langkah analisis One Sample Komogorov Smirnov: a. 

Input data ke dalam SPSS  

  

Tabel 8.5 Data Uji 1-Sample K-S  

Nama  Jenis Kelamin  Pendidikan  
Jumlah 

Produksi (unit)  

Jumlah 

Lembur  

Adi  Laki-laki  SMK  100  1000  

Alif  Laki-laki  SMA  130  1300  

Seli  Perempuan  SMK  110  1100  

Aan  Laki-laki  SMA 100  1000  

Latif  Laki-laki  SMA  110  1100  

Siti  Perempuan  SMA  105  1050  

Devi  Perempuan  SMK  150  1500  

Dea  Perempuan  SMK  190  1900  

Roni  Laki-laki  SMK  200  2000  

Roif  Laki-laki  SMA  160  1600  

Diva  Perempuan  SMA  150  1500  

Danu  Laki-laki  SMA  100  1000  

Darwin  Laki-laki  SMA 120  1200  

Dono  Laki-laki  SMA 140  1400  

Ema  Perempuan  SMK  200  2000  

  

  

  

  

  



85  

  

b. Klik Analyze → Non Parametric Test → 1 Sample K-S  

  

Gambar 8.9 Kotak Dialog One Sample Komogorov Smirnov Test  

  

c. Masukkan variabel Jumlah Produksi ke dalam kotak test variable list. 

Pilih Normal Poisson, Unifrom, dan Exponential di kotak Test 

Distribution.  

d. Klik OK  

  

7. Two Independent Sample Test  

Test uji two independent tes digunakan untuk menetapkan apkah  nilai 

variable tertentu berbeda di antara dua kelompok. Uji two independent 

sample test sama dengan uji independent sample T test dengan persyaratan 

yang lebih longgar.Terdapat dua kelonggaran persyaratan. Pertama, mampu 

digunakan untuk data ordinal dan kedua persyaratan distribusi normal tidak 

terpenuhi, disamping itu jumlah sample tidak terlalu ketat. Uji yang 

dilakukan pada two independent sample test ada dua yaitu uji Mann Whitney 

dan Wilcoxon untuk uji lokasi (dengan jumlah data antara kedua kelompok 

tidak sama dan uji Kolmogorov Smirnov untuk uji lokasi dan bentuk.  

  

a. Uji Mann Whitney  

Anda melakukan pengamatan terhadap pekerja operator mesin bubut 

berdasrkan latar belakang pendidikan SMK dan PT. Data hasil observasi 

adalah sebagai berikut:  
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Tabel 8.6 Data Uji Mann Whitney  

Nama  
Jenis  

Kelamin  
Pendidikan  

Jumlah 

Produksi (unit)  

Jumlah 

Lembur  

Adi  Laki-laki  SMK  100  1000  

Alif  Laki-laki  SMA  130  1300  

Seli  Perempuan  SMK  110  1100  

Aan  Laki-laki  SMA 100  1000  

Latif  Laki-laki  SMA  110  1100  

Siti  Perempuan  SMA  105  1050  

Devi  Perempuan  SMK  150  1500  

Dea  Perempuan  SMK  190  1900  

Roni  Laki-laki  SMK  200  2000  

Roif  Laki-laki  SMA  160  1600  

Diva  Perempuan  SMA  150  1500  

Danu  Laki-laki  SMA  100  1000  

Darwin  Laki-laki  SMA 120  1200  

Dono  Laki-laki  SMA 140  1400  

Ema  Perempuan  SMK  200  2000  

  

Analisis Mann Whitney dapat dilakukan sebagai berikut:  

1. Input data diatas ke dalam SPSS  

2. Klik Analyze → Non Parametric Test → 2 Independent Sample   

  

Gambar 8.10 Kotak Dialog Two Independent Samples Test  

3. Masukkan variabel jumlah produksi ke dalam kotak test variable list. 

Masukkan pendidikan di kotak grouping variable dan pilih uji Mann 

Whitney U (jumlah sampel kedua kelompok berbeda) di kotak Test 

Type.  

4. Klik define groups, masukkan nilai variabel terkait di kotak group 1 

dan 2.  
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Gambar 8.11 Kotak Dialog Two Independent Sample Test: Define Groups  

5. Klik continue.  

6. Klik OK  

Tugas Kelas 

Lakukan pengujian ulang terhadap table 8.5 dan 8.6 apabila ditambah 15 

lulusan dari SMA dan SMK dengan jumlah produksi rata-rata 100-120 dan 

jumlah lembur 1400-2600 
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8. Uji Kolmogorov Smirnov  

Praktikan melakukan pengamatan terhadap operator mesin berdasrkan latar 

belakang pendidikan SMK dan SMA, dua kelompok sampe sama.  

Data hasil observasi adalah sebagai berikut:  

Tabel 8.7 Data Uji Kolmogorov Smirnov  

Nama  Jenis Kelamin  Pendidikan  

Jumlah  

Produksi 

(unit)  

Jumlah 

Lembur  

Adi  Laki-laki  SMK  100  1000  

Alif  Laki-laki  SMA  130  1300  

Seli  Perempuan  SMA  110  1100  

Aan  Laki-laki  SMK 100  1000  

Latif  Laki-laki  SMA  110  1100  

Siti  Perempuan  SMK  105  1050  

Devi  Perempuan  SMK  150  1500  

Dea  Perempuan  SMK  190  1900  

Roni  Laki-laki  SMK  200  2000  

Roif  Laki-laki  SMA  160  1600  

Diva  Perempuan  SMK  150  1500  

Danu  Laki-laki  SMA  100  1000  

Darwin  Laki-laki  SMA 120  1200  

Dono  Laki-laki  SMK 140  1400  

Ema  Perempuan  SMA 200  2000  

Langkah-langkah untuk melakukan uji Komogorov Smirnov, pada dasarnya 

sama dengan pengujian sebelumnya, langakah-langkahnya adalah sebagai 

berikut  

a. Input data di atas ke dalam SPSS  

b. Klik Analyze → Non Parametric Test → 2 Independent Sample   

  

Gambar 8.12 Kotak Dialog Two Independent Samples Tests  
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c. Masukkan variabel jumlah produksi ke dalam kotak test variable list. 

Masukkan pendidikan di kotak grouping variable dan pilih uji 

Kolmogorov Smirnov.  

d. Klik define groups, masukkan nilai variabel terkait di kotak group 1 

dan 2.  

  

Gambar 8.13 Kotak Dialog Two Independent Sample Test: Define Groups  

e. Klik Continue  

f. Klik OK  

Tugas Kelas 

Lakukan pengujian ulang dan analisis terhadap tabel 8.7 apabila ditambah 15 lulusan 

dari SMA dan SMK dengan jumlah produksi rata-rata 100-120 dan jumlah lembur 

1400-2600 
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9. K-Independent Samples Test  

Uji K-Independent Samples Test sama dengan uji ANNOVA tetapi dengan 

persyaratan yang lebih longgar. Uji K independen dapat dilakukan dengan 

prasyarat, yaitu mampu digunakan untuk tipe data oridinal, distribusi normal 

tidak terpenuhi, dan jumlh smpel tidak terlalu ketat. Uji tersebut digunakan 

untuk menetapkan apakah nilai variabel tertentu berbeda pada dua atau lebih 

kelomppok.  

Jenis uji K-independet Sample Test yang seing dilakukan aa dua metode 

yaitu Uji Kruskal Wallis H dan Uji Median.  

  

a. Uji Kruskal Wallis   

Uji Kruskal Wallis adalah analisis varian satu arah dengan rank. Uji ini 

bisa digunakan di data ordinal. Null hipotesis uji ini menyatakan 

multiple independent sample berasal dari populasi yang sama.  

Praktikan melakukan pengendalian kualitas tiga produk baru yang baru 

diproduksi, pengendalian kualitas dilakukan dengan memberi rattig pada 

produk tersebut. Ratting bertipe data oridinal denga rentang 1 sampai 5. 

Nilai semakin tinggi menunnjukkan semakin tinggi kualitasnya. Berikut 

ini adalah data sampel produk tersebut:  

 

   Tabel 8.8 Data UjiKruskal Wallis  

Produk  Kepuasan  

1  2.5  

1  2  

1  2  

1  3.5  

1  4  

1  3  

1  4.5  

1  2  

2  3.5  

2  3  

2  2  

2  2  

2  2  

2  3.5  

2  4  

2  4  

3  2  

3  4.5  



95  

  

Produk  Kepuasan  

3  3  

3  2  

3  3.5  

3  2  

3  4  

3  2  

3 3 

    

Variabel produk merupakan variabel yang diberi value 1= produk a; 2  

= produk b; 3 = produk c  

Analisis Uji Kruskal Wallis dapat dilakukan sebagai berikut:  

1. Input data di atas ke dalam SPSS  

2. Klik Analyze → Non Parametric Test → K- Independent Sample  

  

Gambar 8.14 Kotak Dialog Test fos Several Independent Samples  

3. Masukkan variabel kepuasan ke dalam kotak test variable list, 

masukkan variabel produk pada kotak Grouping Variable dan 

pilih Uji Kruskal Wallis H  

4. Klik define range, masukkan rentang nilai variabel produk pada 

kotak minimum dan maximum .  
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Gambar 5.15 Kotak Dialog Several Independent Sample Test: Define Range  

5. Klik Continue  

6. Klik OK   

Tugas Kelas 

Lakukan pengujian ulang terhadap tabel 8.8 dengan menambah 20 

responden pada masing-masing penilaian produk dan lakukan analisis 
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b. Uji Median  

Uji Median dipakai bila terdapat kelompok-kelompok data yang 

memiliki berbagai distribusi. Null hipotesis uji ini mengatakan dua atau 

lebih sample independent memiliki median yang sama. Praktikan 

melakukan pengamatan p pengaruh tingkat pendidikan terhadap kinerja 

produksi. Tingkat pendidikan dibagi kedalam 3 tingkatan yang berbeda. 

Praktikan melakukan sampling random terhadap operator yang 

pendidikan SMK, SMA dan PT dalam hal jumlah produksi.   

Data sebagai berikut:  

Tabel 8.9 Data Uji Median  

Produk 

Nilai 

Kemasan 

1 2.5 

1 2.0 

1 2.0 

1 3.5 

1 4.0 

1 3.0 

1 4.5 

1 2.0 

2 3.5 

2 3.0 

2 2.0 

2 2.0 

2 2.0 

2 3.5 

2 4.0 

2 4.0 

3 2.0 

3 4.5 

3 3.0 

3 2.0 

3 3.5 

3 2.0 

3 4.0 

3 2.0 

3 2.5 

4 3.1 
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Produk 

Nilai 

Kemasan 

4 2.5 

4 2.1 

4 1.8 

4 2.4 

4 2.9 

4 4.1 

4 3.9 

4 2.7 

4 4.2 

5 3.2 

5 4.1 

5 3.9 

5 3.6 

5 3.5 

 

  Analisis uji median dapat dilakukan sebagai berikut:  

1. Input data di atas ke dalam SPSS  

2. Klik Analyze → Non Parametric Test → K- Independent Sample  

  

Gambar 8.16 Kotak Dialog Test for Several Independent Samples  

3. Masukkan variabel kepuasan ke dalam kotak test variable list, 

masukkan variabel produk pada kotak Grouping Variable dan pilih 

Uji Median.  
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4. Klik define range, masukkan rentang nilai variabel produk pada kotak 

minimum dan maximum.  

  

Gambar 8.17 Kotak Dialog Several Independent Sample Test: Define Range  

5. Klik Continue  

6. Klik OK   

Tugas Kelas 

Lakukan pengujian ulang pada 5 kemasan terbaru dari tabel 8.9 dengan 

rentan nilai yang sama dan lakukan analisis 
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c. Two Related Samples  

Uji Two Related Samples sama dengan uji Paired Samples T test dengan 

prasayarat yang lebih longgar. Kelonggaran prasyarat tersebut adalah 

mampu digunakan baik untuk tipe data ordinal dan skala, apabila 

distribusi normal tidak terpenuhi, dan jumlah sampel juga tidak terlalu 

kuat.  

Test Two Related Samples digunakan untuk menguji perbedaan nilai 

variabel berpasangan atau berhubungan. Ada dua uji yang dapat dilakukan 

pada two related samples yaitu uji Wilcoxon dan uji Mc Nemar.  

Tabel 8.10 Data Uji MRelated Samples  

Nama  
Jenis  

Kelamin  
Pendidikan  

Jumlah  

Produksi 

(unit)  

Jumlah 

Lembur  

Adi  Laki-laki  SMK  100  1000  

Alif  Laki-laki  SMA  130  1300  

Seli  Perempuan  PT  110  1100  

Aan  Laki-laki  PT  100  1000  

Latif  Laki-laki  SMA  110  1100  

Siti  Perempuan  SMA  105  1050  

Devi  Perempuan  SMK  150  1500  

Dea  Perempuan  PT  190  1900  

Roni  Laki-laki  SMK  200  2000  

Roif  Laki-laki  PT  160  1600  

Diva  Perempuan  SMK  150  1500  

Danu  Laki-laki  SMA  100  1000  

Darwin  Laki-laki  PT  120  1200  

Dono  Laki-laki  PT  140  1400  

Ema  Perempuan  SMK  200  2000  

  

d. Uji Wilcoxon dan Sign  

Praktikan melakukan pengamatan berpasangan tentang jumlah produksi 

sebelum dan sesudah diadakan pelatihan operator dibagian produksi 

suatu perusahaan. Responden diambil secara acak sebanyak 15 orang. 

Berikut data jumlah produksi sebelum dan sesudah pelatihan:  
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  Tabel 8.11 Data UjiWilcoxon dan Sign  

Sebelum  Sesudah  

100  130  

85  115  

90  120  

120  150  

95  125  

80  115  

110  140  

100  130  

150  180  

165  195  

120  150  

130  160  

90  120  

80  110  

90 130 

   Uji Sign dan Wilcoxon dapat dilakukan sebagai berikut:  

1. Input data di atas ke dalam SPSS  

2. Klik Analyze → Non Parametric Test → 2 Related Sample Test  

  

Gambar 8.18 Kotak Dialog Two Related Samples T Tests  

3. Blok semua variabel sebelum dan sesudah, masukkan ke dalam 

kotak test Pair(s) list, dengan klik tombol panah sehingga 
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muncul variabel sebelum dan sesudah di kotak tersebut. Beri 

tanda check pada test type yaitu Wilicoxon dan Sign.  

4. Klik OK.  

Tugas Kelas 

Lakukan pengujian ulang pada tabel 8.11 apabila ditambah 15 responden 

dengan hasil sebelum dan sesudah dalam rentan 90-120 dan 130-150  
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e. Uji MC Nemar  

Praktikan melakukan pengamatan terhadap keberhasilan bagian 

pemasaran dalam perusahaan memenuhi target bulanan sebelum dan 

sesudah pelatihan di armada penjualan di suatu perusahaan lain. 

Responden diambil secara random 15 orang dengan data sebagai berikut:  

   Tabel 8.12 Data Uji MC Nemar  

Sebelum  Sesudah  

1  1  

1  1  

2  1  

2  2  

2  1  

1  2  

1  1  

2  1  

2  1  

1  2  

2  2  

2  1  

2  1  

1  1  

1  1  

  

Keterangan:  

Variabel sebelum dan sesudah merupakan variabel dikotomi bertipe data 

nominal, namun diberi value pada variabel tersebut: 2 = tidak berhasil; 

1 = berhasil  

Langkah-langkah dalam melakukan uji MC Nemar adalah sebagai berikut: 
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1. Masukkan data di atas ke dalam SPSS  

2. Klik Analyze → Non Parametric Test → 2 Related Sample Test  

  

Gambar 8.19 Kotak Dialog Two Related Samples T Tests  

3. Blok semua variabel sebelum dan sesudah, masukkan ke dalam kotak 

test Pair(s) list, dengan klik tombol panah sehingga muncul variabel 

sebelum dan sesudah di kotak tersebut. Beri tanda check pada uji MC 

Nemar di dalam Test Type.   

4. Klik OK.  

Tugas Kelas 

Lakukan pengujian ulang terhadap tabel 8.12 apabila terjadi tambahan 25 orang 

dengan hasil sebelum dan sesudah bernilai 50% berhasil 
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BAB IX 

MULTIVARIATE ANALYSIS OF VARIANCE  

(MANOVA)  

  

 Sama dengan ANOVA, MANOVA merupakan uji beda varian. Bedanya, dalam 

ANAVA varian yang dibandingkan berasal dari satu variabel terikat, sedangkan 

pada MANOVA, varian yang dibandingkan berasal dari lebih dari satu variabel 

terikat.    

 Model MANOVA untuk membandingkan vektor mean sebanyak g adalah sebagai 

berikut:  

MANOVA dengan SPSS mengikuti langkah-langkah yang hampir sama dengan 

ANOVA.  

1. Entry Data  

Entry data untuk MANOVA sama halnya dengan ANAVA, yakni variabel terikat 

(y) dimasukkan secara bersambung, dan kelompok dikenali dari variabel bebas 

(x). Hanya saja, dalam MANOVA terdapat lebih dari satu variabel terikat (y1, y2, 

…, yn).  Sebagai contoh, akan dianalisis data untuk menguji hipotesis:   

1.1 Data background  

Dataset ini diambil dari 75 orang dari college frechmen yang ditanyai dengan 

menggunakan kuisoner tentang anggota favorit dari Three Stooges (kelompok 

lawak dari Amerika Serikat). Kuisioner tersebut akan menunjukkan nilai brain 

damage dan stupidity index. Dari data tersebut dapat dilihat apakah terdapat 

perbedaan yang signifikan antara fans dari ketiga anggota Three Stooges (Curly, 

Larry, dan Moe) tersebut, apakah fans dari anggota Three Stooges tersebut berasal 

dari populasi yang sama. Berdasarkan tujuan penelitian tersebut metode statistik 

yang dipakai adalah MANOVA.  

Berikut persamaan MANOVA:  

Y1 + Y2 = X  

Setelah dimasukkan ke form SPSS, data dalam form SPSS akan tampak sebagai 

berikut:  
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Gambar 9.1a Data Uji MANOVA  
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Gambar 9.1b Data Uji MANOVA  

2. Analisis Data   

Menu MANOVA pada SPSS terletak di General Linear Model,  dengan langkah-

langkah sebagai berikut:  

Analyze    General Linear Model  Multiivariate    

Menu akan tampak seperti bagan di bawah ini.   

 

Gambar 9.2 Kotak Dialog Analyze  

Apabila menu tersebut sudah dipilih, maka akan tampak kotak dialog. 

Pindahkan y1 (brain damage) dan y2 (stupidity index) ke dependent variabel 

dan x (favourite) ke fixed factor(s), seperti bagan  berikut.  
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Gambar 9.3 Kotak Dialog Multivariate  

Selanjutnya dipilih kotak option dan dipilih Homogenity Tests, selanjutnya 

pilih continue dan OK, sehingga muncul hasil analisis.    

3. Interpretasi Hasil Analisis   

Interpretasi hasil dilakukan mengikuti mekanisme sebagai berikut.   

a. Uji Homogenitas Varian   

Uji homogenitas varian dilihat dari hasil uji Levene, seperti tampak pada bagan 

berikut ini.  

  
Gambar 9.4 Hasil Uji Homogenitas Varian  

Hasil uji Levene menunjukkan bahwa untuk Brain Damage (Y1) harga 

F=0,638 dan signifikansi 0,531, sedangkan untuk Stupidity Index (Y2) harga 

F=1,783 dengan signifikansi 0,175. Signifikansi kedua dependent variable 

lebih besar dari 0,05. Artinya kedua varian tersebut homogen, sehingga 

MANOVA dapat dilanjutkan.  

b. Uji Homogenitas Matriks Varian/Covarian  

MANOVA mensyaratkan bahwa matriks varian/covarian dari variabel 

dependen sama. Uji homogenitas matriks varian/covarian dilihat dari hasil uji 

Box. Apabila nilai Box’s M signifikan maka hipotesis nol yang menyatakan 

bahwa matriks varian/covarian dari variabel dependen sama ditolak. Dalam 
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kondisi ini analisis MANOVA tidak dapat dilanjutkan. Hasil uji Box’s M dengan 

SPSS tampak pada bagan berikut ini.  

  
Gambar 9.5 Hasil Uji Homogenitas Matriks Varian/Covarian  

  

Harga Box’s M =6,293 dengan signifikansi 0,419. Karena signifikansi 

level melebihi taraf signifikansi penelitian 0,05 sehingga hipotesis null 

diterima (matriks varian/covarian variable dependent sama). Sehingga 

analisis MANOVA dapat dilanjutkan.   

c. Uji MANOVA   

a). Multivariate Test  

Setelah kedua uji persyaratan hipotesis dipenuhi dilanjutkan dengan uji 

hipotesis MANOVA. Uji MANOVA digunakan untuk menguji apakah 

terdapat perbedaan beberapa variabel terikat antara beberapa kelompok yang 

berbeda. Dalam contoh ini apakah terdapat perbedaan yang signifikan antara 

fans dari ketiga anggota Three Stooges (Curly, Larry, dan Moe) tersebut, 

apakah fans dari anggota Three Stooges tersebut berasal dari populasi yang 

sama. Keputusan diambil dengan analisis Pillae Trace, Wilk Lambda, 

Hotelling Trace, Roy’s Largest Root. Hasil analisis untuk contoh di atas adalah 

sebagai berikut.  

 

  

  
Gambar 9.6 Hasil  Multivariate Test   
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Hasil analisis menunjukkan bahwa harga F untuk pillae trace, wilk 

lambda, hotelling trace, roy’s largest root, X memiliki signifikansi 

yang lebih kecil dari 0,05. Artinya, semua harga F signifikan. Jadi, 

terdapat perbedaan brain damage (Y1) dan stupidity index (Y2) 

diakibatkan oleh perbedaan pemilihan anggota favorit Three Stooges.   

  

b). Test of Between Subject Effects  

Test of Between Subject Effects menguji pengaruh univariate ANOVA 

untuk setiap faktor terhadap dependent variable. Berikut hasil SPSS:  

 
Gambar 9.6 Hasil Test of Between Subject Effects  

  

Hubungan antara pemilihan anggota favorit Three Stooges (X) dengan 

brain damage (Y1) memberikan harga F sebesar 2,573 dengan signifikansi 

0.083. Hal ini menunjukkan bahwa tidak terdapat perbedaan antara brain 

damage yang diakibatkan oleh perbedaan pemilihan anggota favorit Three 

Stooges. Di sisi lain, hubungan antara pemilihan anggota favorit Three Stooges 

(X) dengan stupidity index (Y2) memberikan harga F sebesar 7,320 dengan 

signifikansi 0.001. Sehingga dapat disimpulkan bahwa terdapat perbedaan 

antara stupidity index yang diakibatkan oleh perbedaan pemilihan anggota 

favorit Three Stooges.   

Besarnya nilai Adj R2 untuk brain damage adalah 6,7%. 

Sedangkan untuk stupidity index adalah 16,9%. 

            c). Post Hoc    

               Setelah melakukan uji MANOVA lakukan uji Post Hoc untuk menentukan    

          kelompok-kelompok tertentu berbeda satu sama lain dengan langkah sebagai   

          berikut:   
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Gambar 9.7 Kotak Dialog Multivariate  

  

 

Gambar 9.8 Multivariate Post Hoc Multiple Comparisson for Observed  

Means  

  

Selanjutnya akan muncul hasil analisis.  

  

  
  
  
  
  

  
  

  

  

  
  

Post Hoc   
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Gambar 9.9 Hasil Multivariate Post Hoc Multiple Comparisson for  

Observed Means  

  

Hasil uji Turkey, Scheffe, dan LSD menunjukkan bahwa terdapat 

perbedaan stupidity index antara kategori Curly dan Larry yang 

ditunjukkan dengan signifikansi level kurang dari 0,05. Di sisi lain, tidak 

ada perbedaan brain damage antara semua kategori.  

Tugas Kelas 

Jurusan teknik industri memiliki mesin yang ada dalam ruang praktikum yaitu bubut, 

bor, CNC, 3D printing, anthropometer set, body compositor monitor, kursi 

antropometri dan WGBT measurement. Mesin-mesin tersebut diuji berdasarkan 

tingkat kepentingan, kebutuhan dan kegunaan. Oleh karena itu akan dilakukan 

pengambilan kuesioner terhadap 150 mahasiswa teknik industri untuk memenuhi 

kebutuhan pengujian yaitu: 
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1) Sample Size → Kecakupan Data  

2) Missing Data  

3) Outlier → Box Plot  

4) Test Asumsi  

5) Uji Independensi Observasi  

6) Kesetaraan antara varian dan covarian matriks:  

a. Uji Homogenitas varian → leven’s  

b. Uji Homogenitasmatriks varian / covarian  

c. Normality (explore / one sample kolmogonov smirnov)  

d. Korelasi dan linearity dari dependent variabel dan KMO batlet test. 
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BAB X 

REGRESI LINIER   

A. Latar Belakang  

 Masalah tingkat penyakit pada suatu desa banyak yang diteliti apakah faktor-

faktor ini mempengaruhi tingkat angka penyakit di desa tersebut. Faktor yang 

diteliti diantaranya adalah rata-rata lingkungan fisik (X1), lingkungan biologis 

(X2), lingkungan sosial (X3), lingkunan ekonomi (X4), perilaku (X5), 

keturunan (X6) pekerjaan (X7). Dari semua tes yang diberikan akan dianalisis 

hubungan antara variabel independen dan variabel dependen dalam kasus 

tersebut dengan menggunakan analisis regresi linier berganda.  

Tabel 10.1 Data Uji Regresi Linier  

No X1  Y  

1  20  50.23  

2  20  50.50  

3  25  50.91  

4  26  50.10  

5  21  50.78  

6  30  50.45  

7  29  50.12  

8  25  50.40  

9  25  50.42  

10  24  50.67  

11  22  50.99  

12  20  50.29  

13  22  50.15  

14  27  50.60  

15  26  50.30  

16  30  50.33  

17  25  50.25  

18  22  50.55  

19  22  50.35  

20  21  50.41  

21  29  50.37  

22  26  50.65  

23  29  50.83  

24  24  50.64  

25  22  50.35  

26  25  50.42  
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No X1 Y 

27  25  50.52  

28  26  50.75  

29  21  50.35  

30  21  50.57  

31  29  30.34  

32  29  50.22  

33  27  50.65  

34  24  50.43  

35  28  50.85  

36  23  50.46  

37  23  50.57  

38  20  50.52  

39  20  50.47  

40  24  50.53  

41  28  50.55  

42  21  50.62  

43  30  50.41  

44  30  50.48  

45  28  50.58  

46  29  50.63  

47  27  50.18  

48  30  50.52  

49  30  20.40  

50  26  50.67  

51  23  50.42  

52  23  50.85  

53  22  50.7  

54  28  50.71  

55  28  50.74  

56  27  50.42  

57  21  50.64  

58  27  50.72  

59  27  50.46  

60  25  50.45  
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Langkah-langkah dalam melakukan analisis regresi adalah sebagai berikut:  

1. Input data diatas kedalam SPSS   

2. Klik Analyze → Regression → Linier  

  

Gambar 10.1 Kotak Dialog Linear Regression  

3. Masukan variabel nilai X1 pada kotak dependent dan masukan variabel Y 

pada kotak independent (s).  

4. Klik option, maka muncul kotak dialog linier regression: option.  

  

Gambar 10.2 Kotak Dialog Linear regression: options  

5. Gunakan default dari kotak option dan klik continue. Maka kembali ke 

kotak dialog linier regression.  

6. Klik statistik, maka muncul kotak dialog linier regression: statistik.  
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Gambar 10.3 Linear regression statistic  

7. Pada kotak dialog linier regression: statistic, neritanda centang pada kolom 

estimates untuk mengeluarkan koefesien regressi. Selain itu beritanda 

centang pada kotak modelfit dan descriptives. Pada kotak residuals 

beritanda centang pada Durbin-Watson, Casewise diagnostics kemudian 

pilih All cases.  

8. Klik Continue.  

9. Klik Plots, maka akan muncul kotak dialog linier regression: plots  

 
Gambar 10.4 Kotak dialog linear regression: plot  

10. untuk membuat plot antara SDRESID dan ZPRED maka masukan peubah  

SDRESID ke dalam ruang Y dan ZPRED ke dala ruang X. Kemudian klik 

Next  

11. Untuk membuat plot antara ZPRED dengan DEPENDT maka masukan 

peubah standardized residual plots pilih normal probability plot.  

12. Klik continue  

13. Klik OK  
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1. Analisis Variabel Entered Removed   

Menunjukkan metode regresi linier yang dipilih, yaitu enter → Memasukkan 

semua variabel independen sekaligus untuk dianalisis  

2. Analisis Model Summary  

Menunjukkan Nilai Koefisien Korelasi (R) yang menunjukkan tingkat hubungan 

antar variabel  

3. Analisis Tabel Anova  

Memaparkan uji kelinearan (analisis sama dengan analisis ANOVA)  

4. Tabel Coefficient  

Memaparkan nilai konstanta a dan b dari persamaan linear y 

= a + bx   

 

Tugas Kelas 

Lakukan pengujian ulang terhadap tabel 10.1 apabila dilakukan pada 100 responden 

dengan renang nilai X1 20-30 dan Y 50-51 dan analisis  
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Regresi Linier Beberapa Variabel Independent  

 Analisis regresi linear berganda adalah pengembangan dari analisa regresi linear 

sederhana dimana terdapat lebih dari satu variabel independent x. Analisa ini 

digunakan untuk melihat sejumlah variabel independen 𝑥1, 𝑥2 …. 𝑥𝑘 terhadap 

variabel dependent y berdasarkan nilai variabel-variabel independent 𝑥1, 𝑥2 …. 𝑥𝑘.   

Suatu perusahaan melakukan penilaian terhadap tingkat kepuasan kenyamanan, 

kelembaban, pencahayaan, kebisingan, kesejukan, kerapian, dan kebersihan suatu 

ruangan pada 60 karyawan kemudian dilanjutkan analisis dan didapat hasil sebagai 

berikut: 

Tabel 10.2a Data Uji Regresi Linier Beberapa Variabel Independent  

NO X1  X2  X3  X4  X5  X6  X7  Y  

1  20  30  25  25  22  29  21  50.23  

2  20  22  30  22  20  25  21  50.50  

3  25  28  28  30  20  25  21  50.91  

4  26  23  25  25  29  30  24  50.10  

5  21  21  22  25  26  22  24  50.78  

6  30  25  29  26  25  21  29  50.45  

7  29  27  20  23  23  25  25  50.12  

8  25  23  30  21  28  27  30  50.40  

9  25  29  30  29  28  29  29  50.42  

10  24  29  22  27  25  29  29  50.67  

11  22  21  25  26  21  26  25  50.99  

12  20  30  27  24  30  23  27  50.29  

13  22  30  25  30  26  22  22  50.15  

14  27  25  25  20  23  30  22  50.60  

15  26  25  25  20  22  21  20  50.30  

16  22  27  22  29  30  29  29  50.33  

17  26  31  20  26  28  26  25  50.25  

18  24  20  20  23  28  23  25  50.55  

19  22  25  29  22  24  22  30  50.35  

20  20  29  26  30  25  30  22  50.41  

21  25  24  25  30  29  30  21  50.37  

22  27  23  23  28  26  30  25  50.65  

23  24  22  28  28  23  28  27  50.83  

24  25  28  28  24  22  25  29  50.64  

25  25  20  25  25  30  23  29  50.35  

26  26  21  21  29  26  30  20  50.42  
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NO X1  X2  X3  X4  X5  X6  X7  Y  

27  21  26  30  26  29  28  29  50.52  

28  23  29  26  23  27  28  26  50.75  

29  29  24  23  22  27  24  25  50.35  

30  28  23  22  30  28  25  23  50.57  

31  24  23  25  30  21  25  28  30.34  

32  29  30  25  28  21  25  28  50.22  

33  24  25  25  28  21  25  25  50.65  

34  30  22  25  24  20  22  21  50.43  

35  30  20  25  25  27  26  30  50.85  

36  28  20  22  22  25  24  26  50.46  

37  28  29  26  20  25  30  23  50.57  

38  24  26  30  20  22  30  22  50.52  

39  25  25  28  29  26  28  20  50.47  

40  25  23  28  26  30  28  22  50.53  

41  22  28  24  25  28  24  25  50.55  

42  26  28  25  23  28  25  25  50.62  

43  25  25  22  28  24  25  22  50.41  

44  24  21  24  28  25  22  26  50.48  

45  29  30  30  25  22  26  23  50.58  

46  21  26  30  21  25  25  25  50.63  

47  23  23  28  30  25  24  27  50.18  

48  27  22  28  26  22  29  24  50.52  

49  25  26  24  23  26  21  30  20.40  

50  28  22  25  22  28  23  30  50.67  

51  30  29  25  29  30  27  28  50.42  

52  21  30  22  25  22  25  28  50.85  

53  29  30  26  25  20  28  24  50.57  

54  28  27  25  30  20  30  25  50.71  

55  26  29  24  22  29  28  25  50.74  

56  28  25  29  21  26  28  22  50.42  

57  26  22  21  25  25  24  26  50.64  

58  21  20  23  27  23  25  25  50.72  

59  20  20  27  29  28  25  24  50.46  

60  26  29  25  29  28  22  29  50.45  
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Langkah-langkah melakukan analisis regresi linear beberapa variabel independent 

pada dasarnya sama seperti regresi linear satu variabel.  

1. Input data di atas ke dalam SPSS.  

2. Klik Analyze → Regression → Linier  

  

Gambar 10.5 kotak dialog linear regression  

3. Klik statistics, langkahnya sama dengan regresi sederhana atau regresi satu 

variabel  

  

4. Klik options, langkahnya sama dengan regresi sederhana atau regresi satu 

variabel  

  

5. Klik OK  

  

y = a + b1x1 + b2x2 + b3x3 + .... + bnxn 

y = variabel dependen x1 , x2= 

variabel independen  

a = konstanta, perpotongan garis pada sumbu x1 b1, 

b2, bn= koefisien regresi  

Tugas Kelas 

Lakukan pengujian ulang apabila ditambah 40 karyawan kemudian lakukan analisis 

kembali! 

Tugas Praktikum (mingguan):  

A. Buatlah persamaan regresi dari suatu kasus dengan banyak variabel.  

B. Langkah-langkah yang harus dilakukan adalah sebagai berikut:  
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a. Latar belakang masalah  

b. Normality test  

c. Uji Multikolinearitas  

d. Homoscedasticity test  

e. Uji Autokorelasi  

f. Uji F  

g. Goodness of Fit test  

h. Penarikan kesimpulan  
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BAB XI  

ANALISIS FAKTOR  

  

Dengan analisis faktor, kita akan memperoleh hasil sebagai berikut:  

1. Identifikasi dimensi-dimensi atau faktor-faktor mendasar yang dapat 

menjelaskan korelasi dari serangkaian variabel.  

2. Identifikasi variabel-variabel baru yang lebih kecil untuk menggantikan 

variabel yang tidak berkorelasi dari serangkaian variabel asli (asal) yang 

berkorelasi dari analisa multivariate (analisis regresi atauanalisis 

diskriminan).  

3. Identifikasi variabel-variabel kecil yang menonjol (dari variabel yang lebih 

besar) dari suatu analisis multivariate.  

Pada analisis faktor, asumsi yang harus terpenuhi adalah sebagai berikut:  

1. Korelasi antar variabel Independen. Besar korelasi atau korelasi antar 

independen variabel harus cukup kuat, misalnya di atas 0,5.  

2. Korelasi Parsial. Besar korelasi parsial, korelasi antar dua variabel dengan 

menganggap tetap variabel yang lain, justru harus kecil.  

Pada SPSS deteksi terhadap korelasi parsial diberikan lewat pilihan 

AntiImage Correlation.  

3. Pengujian seluruh matriks korelasi (korelasi antar variabel), yang diukur 

dengan besaran Bartlett Test of Sphericity atau Measure Sampling 

Adequacy (MSA). Pengujian ini mengharuskan adanya korelasi yang 

signifikan di antara paling sedikit beberapa variabel.  

4. Pada beberapa kasus, asumsi Normalitas dari variabel-variabel atau faktor 

yang terjadi sebaiknya dipenuhi.  

Seorang dokter melakukan pengujian pada 50 pasien terhadap leng, muscle, liver, 

skeleton, kidneys, heart, step, stamina, stretch, blow, dan urine untuk mengetahui 

kondisi setelah dilakukan operasi kemudian didapat hasil sebagai berikut: 

Tabel 11.1 Data Hasil Operasi 

Pasien Lung Muscle Liver Sceleton Kidneys Heart Step Stamina Strech Blow Urine 

1 1.03 .23 .53 .38 .47 .55 .40 1.60 .69 .53 .47 

2 1.04 .26 .53 .47 .43 .55 .45 1.58 .45 .54 .45 

3 1.02 .26 .54 .41 .43 .55 .42 1.62 .55 .46 .42 

4 1.03 .22 .46 .38 .38 .52 .45 1.60 .53 .53 .45 

5 1.04 .22 .53 .38 .39 .52 .42 1.60 .55 .45 .42 

6 1.03 .22 .45 .42 .47 .56 .38 1.55 52.00 .42 .38 

7 1.04 .22 .42 .40 .43 .56 .47 1.55 47.00 .52 .47 

8 1.04 .24 .52 .41 .43 .52 .41 1.59 65.00 .51 .41 

9 1.02 .22 .51 .44 .38 .52 .38 1.68 46.00 .53 .38 

10 1.01 .24 .53 .45 .39 .55 .38 1.70 51.00 .57 .38 

11 1.03 .24 .57 .40 .45 .53 .42 1.65 67.00 .47 .42 

12 1.01 .23 .47 .44 .40 .55 .40 1.60 45.00 .45 .40 

13 1.01 .26 .45 .40 .38 .55 .47 1.60 67.00 .55 .41 

14 1.03 .26 .45 .45 .40 .55 .41 1.60 59.00 .54 .44 

http://www.statistikian.com/2014/03/analisis-faktor.html
http://www.statistikian.com/2014/03/analisis-faktor.html
http://www.statistikian.com/2014/03/analisis-faktor.html
http://www.statistikian.com/2012/08/korelasi.html
http://www.statistikian.com/2012/08/korelasi.html
http://www.statistikian.com/2012/08/korelasi.html
http://www.statistikian.com/2012/10/variabel-penelitian.html
http://www.statistikian.com/2012/10/variabel-penelitian.html
http://www.statistikian.com/2012/10/variabel-penelitian.html
http://www.statistikian.com/2012/08/analisis-regresi-korelasi.html
http://www.statistikian.com/2012/08/analisis-regresi-korelasi.html
http://www.statistikian.com/2013/12/analisis-diskriminan.html
http://www.statistikian.com/2013/12/analisis-diskriminan.html
http://www.statistikian.com/2013/12/analisis-diskriminan.html
http://www.statistikian.com/2013/12/analisis-diskriminan.html
http://statistikian.blogspot.com/p/spss.html
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Pasien Lung Muscle Liver Sceleton Kidneys Heart Step Stamina Strech Blow Urine 

15 1.04 .24 .53 .38 .42 .52 .38 1.58 49.00 .41 .45 

16 1.02 .22 .53 .47 .41 .56 .38 1.62 61.00 .57 .40 

17 1.02 .22 .54 .45 .40 .56 .42 1.60 56.00 .53 .44 

18 1.01 .22 .46 .42 .47 .52 .40 1.60 49.00 .45 .40 

19 1.03 .24 .53 .45 .46 .52 .41 1.55 54.00 .52 .45 

20 1.03 .22 .45 .42 .44 .55 .44 1.55 61.00 .53 .38 

21 1.02 .24 .42 .38 .45 .53 .45 1.59 60.00 .46 .47 

22 1.02 .24 .52 .47 .40 .55 .40 1.68 55.00 .57 .45 

23 1.02 .26 .51 .41 .38 .52 .44 1.70 56.00 .53 .42 

24 1.01 .24 .53 .38 .40 .56 .40 1.65 66.00 .46 .45 

25 1.02 .22 .57 .38 .42 .56 .45 1.60 70.00 .53 .42 

26 1.01 .22 .47 .42 .41 .52 .38 1.60 65.00 .45 .38 

27 1.04 .22 .45 .40 .40 .52 .47 1.59 50.00 .42 .47 

28 1.03 .24 .55 .41 .47 .55 .45 1.68 49.00 .52 .41 

29 1.03 .22 .54 .44 .46 .53 .42 1.70 46.00 .51 .38 

30 1.02 .24 .41 .45 .44 .55 .45 1.65 63.00 .53 .38 

31 1.03 .24 .57 .40 .47 .55 .42 1.60 45.00 .57 .42 

32 1.03 .23 .53 .44 .43 .55 .38 1.60 70.00 .47 .40 

33 1.03 .26 .45 .40 .43 .52 .47 1.60 45.00 .45 .41 

34 1.03 .26 .52 .45 .38 .56 .38 1.58 62.00 .45 .44 

35 1.04 .24 .53 .38 .39 .56 .38 1.62 65.00 .45 .45 

36 1.03 .22 .46 .47 .45 .52 .42 1.60 53.00 .53 .38 

37 1.03 .22 .57 .45 .40 .52 .40 1.60 49.00 .53 .47 

38 1.01 .22 .53 .42 .38 .55 .41 1.55 50.00 .54 .41 

39 1.01 .24 .46 .45 .40 .53 .44 1.55 49.00 .46 .38 

40 1.03 .23 .53 .42 .42 .55 .45 1.59 67.00 .53 .38 

41 1.04 .25 .45 .38 .41 .52 .40 1.68 63.00 .45 .42 

42 1.01 .25 .42 .47 .40 .56 .44 1.70 60.00 .42 .40 

43 1.04 .25 .52 .41 .47 .56 .40 1.56 61.00 .52 .41 

44 1.03 .23 .51 .38 .46 .52 .45 1.67 67.00 .51 .44 

45 1.04 .22 .53 .38 .44 .52 .38 1.65 70.00 .53 .45 

46 1.02 .24 .57 .42 .45 .55 .47 1.53 66.00 .57 .40 

47 1.04 .22 .47 .40 .40 .52 .45 1.54 49.00 .47 .44 

48 1.02 .24 .45 .41 .40 .56 .42 1.63 61.00 .45 .40 

49 1.03 .24 .45 .44 .42 .56 .45 1.57 51.00 .45 .45 

50 1.02 .23 .45 .45 .41 .52 .42 1.60 46.00 .53 .38 

 

 

Sebagai contoh, kita akan melakukan analisis faktor pada 11 variabel. Langkahnya 

adalah sebagai berikut:  

1. Pada menu SPSS, klik Analyze, Data Reduction, Factor. Masukkan semua 

variabel ke dalam kotak "Variables".   
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Gambar 11.1 Analisis Faktor  

2. Tekan tombol "Descriptives" kemudian centang "Univariate descriptives", 

"Initial Solutions", "Coefficients", "Significance Levels", "Determinant", 

"KMO and Bartlett`s test of sphericity" dan "Anti Image". Klik "Continue".  

 
  

Gambar 11.2 Kotak Dialog Deskriptive Analisis Faktor  

3. Tekan tombol "Extractions" kemudian pilih "Principal components" sebagai 

method, pada "Analyze" pilih "Correlation matrix", pada "display" pilih 

"Unrotated factor solution" dan "Scree plot". Pada extract, pilih Eigenvalue over 

dan isi dengan angka "1". Klik "Continue".  

  

  

  



141  

  

 
  

Gambar 11.3 Kotak Dialog Extraction  

4. Tekan tombol "Rotation" kemudian centang "Varimax" dan pada display 

centang semua, yaitu "Rotated solutions" dan "Loading plot(s)". Klik 

"Continue".  

 
  

Gambar 11.4 Kotak Dialog Rotation  

  

5. Tekan tombol "Options" kemudian centang "Sorted by Size".  

  

Analisis Faktor Options  

http://1.bp.blogspot.com/-7k9kP0ZB4FA/UzhZ4V4bIMI/AAAAAAAACcY/IgwdgX9-jpk/s1600/Analisis+factor+proses+extraction.JPG


142  

  

  

Gambar 11.5 Kotak Dialog Options  

  

langkah ini bukan langkah terakhir dalam analisis faktor, karena analisis Anda 

dapat dilakukan secara berulang hingga syarat minimal nilai KMO, Bartlett's 

Sphericity, MSA dan Communalities terpenuhi.  

  

Output SPSS Anda ditunjukkan pada gambar berikut:  

 

Tabel Matrix Korelasi  

  

Matrik korelasi dikatakan antar variabel saling terkait apabila determinan bernilai 

mendekati nilai 0. Hasil perhitungan menunjukkan nilai Determinant of 

Correlation Matrix sebesar 0,67. Nilai ini mendekatai 0, dengan demikian matriks 

korelasi antara variabel saling terkait.  

  

 

http://1.bp.blogspot.com/-hsqbEVlk25o/UzhhHAAELUI/AAAAAAAACcw/cw_ng9DoRaQ/s1600/Analisis+factor+proses+sorted.JPG
http://statistikian.blogspot.com/2012/10/variabel-penelitian.html
http://statistikian.blogspot.com/2012/10/variabel-penelitian.html
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KMO dan Bartlett Test of Sphericity  

Kaiser Meyer Olkin Measure of Sampling (KMO) adalah indeks perbandingan 

jarak antara koefisien korelasi dengan koefisien korelasi parsialnya. Jika jumlah 

kuadrat koefisen korelasi parsial di antara seluruh pasangan variabel bernilai kecil 

jika dibandingkan dengan jumlah kuadrat koefisien korelasi, maka akan 

menghasilkan nilai KMO mendekati 1. Nilai KMO dianggap mencukupi jika lebih 

dari 0,5. Hasil penelitian menunjukkan bahwa nilai Kaiser Meyer Olkin Measure 

of Sampling sebesar 0,687. Maka persyaratan KMO sudah memenuhi karena 

memiliki nilai di atas 0,5.  

Hasil nilai Barlett Test of Spehricity sebesar 207,690 dengan signifikansi sebesar 

0,000. Dengan demikian Bartlett Test of Spehricity memenuhi persyaratan karena 

signifikansi di bawah 0,05 (5%).  

Measures of Sampling Adequacy (MSA) Pengujian persyaratan MSA terhadap 9 

variabel, dijelaskan pada tabel berikut:  

 
  

Tabel Anti Image Matrix  

Nilai MSA pada tabel di atas ditunjukkan pada baris Anti Image Correlation 

dengan tanda "a". Misal X1 nilai MSA = 0,741 dimana > 0,5 maka X1 memenuhi 

syarat MSA, sedangkan MSA X2 = 0,110< 0,5 maka X2 tidak memenuhi syarat 

MSA. Dari 9 variabel, hanya X2 dengan MSA < 0,5, maka X2 dikeluarkan dari 

pengujian. Sehingga anda harus mengulangi langkah analisis faktor seperti pada 

artikel sebelumnya, yaitu: analisis faktor dengan SPSS tanpa mengikutsertakan X2.  
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Silahkan ulangi lagi, dan kembali lihat nilai Determinant, KMO, Barlett Test of 

Spehricity dan MSA.  

  

Setelah anda ulangi tanpa X2, maka lihat nilai Determinant: 0,67.  KMO, yaitu: 

0,687. Barlett Test of Spehricity: 330,649 dengan sig: 0,000. Maka syarat KMO 

dan Barlett Test of Spehricity terpenuhi. Selanjutnya kembali lihat nilai MSA:  

 

Tabel MSA  

Berdasarkan tabel di atas, masih ada variabel dengan MSA < 0,5 yaitu X3. Maka 

ulangi lagi proses analisis tanpa mengikutsertakan X3.  

Kemudian cek ulang, dan hasilnya sebagai berikut:  

 

Tabel Determinant  

Setelah diulangi tanpa X3, maka nilai Determinant: 0,085.  
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KMO Step 2  

Setelah diulangi tanpa X3, maka nilai KMO: 0,688. Barlett Test of Spehricity: 

302,334 dengan sig: 0,000. Maka syarat KMO dan Barlett Test of Spehricity 

terpenuhi. Selanjutnya kembali lihat nilai MSA:  

 
  

MSA Step 2  

Dari tabel di atas menunjukkan bahwa 7 variabel diuji memenuhi persyaratan MSA 

yaitu di atas 0,5 sehingga dapat digunakan untuk pengujian selanjutnya.  

 

Komunalitas Step 2  

Dari tabel di atas menujukkan 7 variabel diuji memenuhi persyaratan komunalitas 

yaitu lebih besar dari 0,5 (komunalitas > 0,5). Jika ada variabel dengan nilai 

Extraction pada tabelCommunalities < 0,5, maka variabel tersebut tidak memenuhi 
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syarat komunalitas dan harus dikeluarkan dari pengujian serta anda harus 

mengulangi langkah analis faktor dari awal tanpa mengikutsertakan variabel yang 

tidak memenuhi syarat komunalitas. Pengulangan tersebut sama dengan cara 

pengulangan pada syarat MSA yang telah dijelaskan di atas.  

Untuk interprestasi selanjutnya yaitu pembentukan component faktor, rotasi faktor, 

scree plot dan faktor skor. Scree plot merupakan suatu plot dari eigenvalue sebagai 

fungsi banyaknya faktor. Hasilnya menunjukkan bahwa titik pada tempat dimana 

the scree mulai terjadi, menunjukkan banyaknya faktor yang benar. Semakin tinggi 

eigenvalue, semakin tinggi pula proporsi varian yang ada pada faktor.  

Communalities  

 
  

Tabel Communalities  

Tabel di atas menunjukkan seberapa besar sebuah variabel dapat menjelaskan 

faktor. Misal X1 nilainya 0,528, artinya variabel X1 dapat menjelaskan faktor 

sebesar 52,8%. Begitu pula dengan variabel lainnya, di mana semuanya > 50%, oleh 

karenanya dapat disimpulkan bahwasanya semua variabel dapat menjelaskan 

faktor.  

Faktor Yang Sekiranya Dapat Terbentuk  

Tabel Total Variance Explained di bawah ini berguna untuk menentukan 

berapakah faktor yang mungkin dapat dibentuk.  

 

Tabel Eigenvalue  

Berdasarkan tabel di atas, lihat kolom "Component" yang menunjukkan bahwa ada 

7 komponen yang dapat mewakili variabel. Perhatikan kolom "Initial Eigenvalues" 

http://statistikian.blogspot.com/2012/10/variabel-penelitian.html
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yang dengan SPSS kita tentukan nilainya 1 (satu). Varians bisa diterangkan oleh 

oleh faktor 1 adalah 3,307/7 x 100% = 47,242. Oleh faktor 2 sebesar 1,416/7 x 

100% = 20,228. Sementara oleh faktor 3 sebesar 1,066/7 x 100% = 15,228. 

Sehingga total ketiga faktor akan mampu menjelaskan variabel sebesar 47,242% + 

20,228% + 15,228% = 82,698%. Dengan demikian, karena nilai Eigenvalues yang 

ditetapkan 1, maka nilai Total yang akan diambil adalah yang > 1 yaitu component 

1, 2 dan 3.  

  

Factor Loading  

Setelah kita mengetahui bahwa faktor maksimal yang bisa terbentuk adalah 3 faktor, 

selanjutnya kita melakukan penentuan masing-masing variabel akan masuk ke 

dalam faktor mana, apakah faktor 1, 2 atau 3. Cara menentukan tersebut adalah 

dengan melihat tabel Component Matrix seperti di bawah ini:  

 
  

Tabel Component Matrix  

  

Tabel di atas menunjukkan seberapa besar sebuah variabel berkorelasi dengan 

faktor yang akan dibentuk. Misal: X5 berkorelasi sebesar 0,885 dengan faktor 1, 

0,405 dengan faktor 2 dan 0,004 dengan faktor 3.  

Secara jelasnya dapat anda lihat pada tabel Rotated Component Matrix di bawah 

ini untuk menentukan variabel mana akan masuk faktor yang mana.  
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Tabel Rotated Component Matrix  

Penentuan variabel masuk faktor mana ditentukan dengan melihat nilai korelasi 

terbesar. Pada tabel di atas telah diurutkan dari nilai yang terbesar ke yang terkecil 

per faktor. Perhatikan baik-baik di atas:  

Skeleton korelasi terbesar dengan faktor 1 yaitu 0,804, begitu pula stretch: 0,752 

dan lung: 0,487. Yang paling berkorelasi dengan faktor 2 adalah urine: 0,797, blow: 

0,666. Sedangkan heart sebesar 0,823 lebih berkorelasi dengan faktor 3, begitu juga 

dengan kidneys: 0,756 masuk ke faktor 3. Maka dapat disimpulkan anggota masing-

masing faktor:  

Faktor 1: skeleton, stretch  

Faktor 2: urine, blow, stamina  

Faktor 3: heart, kidneys  

Langkah terakhir untuk penentuan faktor adalah melihat tabel Component 

Transformation Matrix.  

 
  

Tabel Transformation Matrix  

Tabel di atas menunjukkan bahwa pada component 1 nilai korelasi 0,651> 0,5, 

component 2: 0,705> 0,5 dan component 3: 0,641> 0,5. Karena semua component 

> 0,5 maka ketiga faktor yang terbentuk dapat dikatakan tepat dalam merangkum 

ketujuh variabel yang ada.  

Factor Score  

Setelah anda mendapatkan faktor-faktor yang terbentuk, maka langkah selanjutnya 

untuk keperluan analisis lebih lanjut, anda dapat menentukan faktor skor. Caranya 

adalah dengan mengulangi langkah analisis faktor tetapi pada saat proses anda 

tekan tombol "Scores", kemudian centang "Save as variables" dan pilih method 

"Regression".  

http://statistikian.blogspot.com/2012/08/korelasi.html
http://statistikian.blogspot.com/2012/08/korelasi.html
http://statistikian.blogspot.com/2012/08/korelasi.html
http://statistikian.blogspot.com/2012/08/korelasi.html
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Gambar 11.6 Kotak Dialog Analisis Faktor  

Setelah anda klik "Continue" dan "OK" pada jendela utama, maka lihat pada 

dataset anda di "data view".  

   
  

Gambar 6.12 Factor Scor  

Lihat bahwa muncul variabel baru, yaitu FAC1 1 yang merupakan faktor skor dari 

faktor 1, FAC2_1 yang merupakan faktor skor dari faktor 2 dan FAC3_1  yang 

merupakan faktor skor dari faktor 3.     
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Tugas Kelas:  

Data berasal dari [Kendall M. (1975). Multivariate analysis. Griffin, London] 

data berkorespondensi dengan 48 pelamar untuk posisi di perusahaan yang telah 

dinilai berdasarkan 15 variabel berikut: Form of letter of application, 

Appearance, Academic ability, Likeability, Self-confidence, Lucidity, Honesty, 

Salesmanship, Experience Drive, Ambition Grasp, Potential Keenness to join, 

Suitability. Lakukan uji analisis factor untuk untuk menentukan faktor-faktor 

mendasar yang ada. 

D. Langkah-langkah yang harus dilakukan adalah sebagai berikut:  

a. Examining data  

1. Sample size  

2. Graphical Examination of the Data (Analisis Distribusi, Analisis 

Relationship antara Variabel)  

3. Missing data  

4. Outlier data (Box and Whiskers Plot)  

5. Testing  the  assumption  (Normalitas,  Linearitas,  

Homoscedasticity)  

b. Factor Analysis  

Kerjakan menggunakan data set berikut:  

 Obs 

Form of 

letter of 

application 

Appearance 
Academic 

ability 
Likeability 

Self-

confidence 
Lucidity Honesty Salesmanship Experience Drive Ambition Grasp Potential 

Keeness 

to join 
Suitability 

1 6 7 2 5 8 7 8 8 3 8 9 7 5 7 10 

2 9 10 5 8 10 9 9 10 5 9 9 8 8 8 10 

3 7 8 3 6 9 8 9 7 4 9 9 8 6 8 10 

4 5 6 8 5 6 5 9 2 8 4 5 8 7 6 5 

5 6 8 8 8 4 4 9 5 8 5 5 8 8 7 7 

6 7 7 7 6 8 7 10 5 9 6 5 8 6 6 6 

7 9 9 8 8 8 8 8 8 10 8 10 8 9 8 10 

8 9 9 9 8 9 9 8 8 10 9 10 9 9 9 10 

9 9 9 7 8 8 8 8 5 9 8 9 8 8 8 10 

10 4 7 10 2 10 10 7 10 3 10 10 10 9 3 10 

11 4 7 10 0 10 8 3 9 5 9 10 8 10 2 5 

12 4 7 10 4 10 10 7 8 2 8 8 10 10 3 7 

13 6 9 8 10 5 4 9 4 4 4 5 4 7 6 8 

14 8 9 8 9 6 3 8 2 5 2 6 6 7 5 6 

15 4 8 8 7 5 4 10 2 7 5 3 6 6 4 6 

16 6 9 6 7 8 9 8 9 8 8 7 6 8 6 10 

17 8 7 7 7 9 5 8 6 6 7 8 6 6 7 8 

18 6 8 8 4 8 8 6 4 3 3 6 7 2 6 4 

19 6 7 8 4 7 8 5 4 4 2 6 8 3 5 4 

20 4 8 7 8 8 9 10 5 2 6 7 9 8 8 9 

21 3 8 6 8 8 8 10 5 3 6 7 8 8 5 8 

22 9 8 7 8 9 10 10 10 3 10 8 10 8 10 8 

23 7 10 7 9 9 9 10 10 3 9 9 10 9 10 8 

24 9 8 7 10 8 10 10 10 2 9 7 9 9 10 8 

25 6 9 7 7 4 5 9 3 2 4 4 4 4 5 4 
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26 7 8 7 8 5 4 8 2 3 4 5 6 5 5 6 

27 2 10 7 9 8 9 10 5 3 5 6 7 6 4 5 

28 6 3 5 3 5 3 5 0 0 3 3 0 0 5 0 

29 4 3 4 3 3 0 0 0 0 4 4 0 0 5 0 

30 4 6 5 6 9 4 10 3 1 3 3 2 2 7 3 

31 5 5 4 7 8 4 10 3 2 5 5 3 4 8 3 

32 3 3 5 7 7 9 10 3 2 5 3 7 5 5 2 

33 2 3 5 7 7 9 10 3 2 2 3 6 4 5 2 

34 3 4 6 4 3 3 8 1 1 3 3 3 2 5 2 

35 6 7 4 3 3 0 9 0 1 0 2 3 1 5 3 

36 9 8 5 5 6 6 8 2 2 2 4 5 6 6 3 

37 4 9 6 4 10 8 8 9 1 3 9 7 5 3 2 

38 4 9 6 6 9 9 7 9 1 2 10 8 5 5 2 

39 10 6 9 10 9 10 10 10 10 10 8 10 10 10 10 

40 10 6 9 10 9 10 10 10 10 10 10 10 10 10 10 

41 10 7 8 0 2 1 2 0 10 2 0 3 0 0 10 

42 10 3 8 0 1 1 0 0 10 0 0 0 0 0 10 

43 3 4 9 8 2 4 5 3 6 2 1 3 3 3 8 

44 7 7 7 6 9 8 8 6 8 8 10 8 8 6 5 

45 9 6 10 9 7 7 10 2 1 5 5 7 8 4 5 

46 9 8 10 10 7 9 10 3 1 5 7 9 9 4 4 

47 0 7 10 3 5 0 10 0 0 2 2 0 0 0 0 

48 0 6 10 1 5 0 10 0 0 2 2 0 0 0 0 
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